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About This Guide

GroupWise Web Services provides developers with server-side access to user mailboxes. This
programmatic access allows you to read and write directly to users’ mailboxes by using industry
standards such as XML, SOAP, and HTTP.

IMPORTANT: Unless otherwise marked, the features in GroupWise Web Services work with
GroupWise 8 and later versions.

This guide contains the following sections:

¢ Chapter 1, “Overview,” on page 13

¢ Chapter 2, “Methods,” on page 73

+ Chapter 3, “Schema Elements,” on page 269
Audience

This guide is intended for GroupWise developers.

Feedback

We want to hear your comments and suggestions about this manual and the other documentation
included with this product. Please use the User Comment feature at the bottom of each page of the
online documentation.
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Overview

GroupWise Web Services provides developers with server-side access to user mailboxes. This
programmatic access allows you to read and write directly to users’ mailboxes by using industry
standards such as XML, SOAP, and HTTP.

GroupWise Web Services communicates directly with a user’s post office agent (POA), and
GroupWise schemas define the methods and structures that are used in the conversation with the
GroupWise POA.

The GroupWise Web Services schema definition file (WSDL) provides the tools you need to hook into
integrated development environment (IDE) frameworks that support Web Services.

For the tools you need to hook into IDE frameworks that support Web Services, GroupWise Web
Services also uses the GroupWise Web Services Definition Language (WSDL).

In addition to GroupWise Web Services, GroupWise gives you access to events or actions that occur
on a GroupWise user's mailbox. This extension to GroupWise Web Services is called GroupWise
Events. GroupWise Events is a Web service that allows you to programmatically configure and
retrieve specific GroupWise events that have occurred on a user's mailbox.

GroupWise Events and GroupWise Web Services should be used together. To learn more about
GroupWise Events, see GroupWise SDK: Web Services Events.

GroupWise Web Services and GroupWise Web Services Events are available on the following
platforms:

+ Linux

+ NetWare (Not available for GroupWise 2012 and later versions)

+ Windows
This section contains the following topics:

+ “Information Resources” on page 14

+ “Overview” on page 14

+ “Web Services on a POA” on page 15

+ “SOAP Requests” on page 16

¢ “Custom Fields on GroupWise Items” on page 17
+ “All Day Events and Time Zones” on page 18
+ “Debugging Tips” on page 20

+ “Free/Busy” on page 20

+ “Getting Items” on page 24

¢ “HTTP Connections” on page 33

+ “Message Bodies” on page 34

+ “Proxy” on page 38

Overview 13
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+ “Recurrence” on page 38

+ “Redirection” on page 40

+ “Streaming Attachments” on page 41

+ “Trusted Application” on page 45

+ “Filters and Views” on page 45

+ “ContactNotes on a Contact” on page 66
+ “Display Settings” on page 69

+ “ltem Modification” on page 70

Information Resources

Before using GroupWise Web Services, you should be familiar with XML, SOAP, and HTTP concepts.
You can find more information with the following links:

+ GroupWise Documentation

*

HTTP page (https://www.w3.org/Protocols/Specs.html)
SOAP

¢ Part O (https://www.w3.0rg/TR/soap12-part0/)

¢ Part 1 (https://www.w3.0rg/TR/soap12-partl/)

¢ Part 2 (https://www.w3.0rg/TR/soap12-part2/)

*

*

XML Schema Specifications
+ Overview (https://www.w3.org/XML/Schema)
¢ Part 0 (https://www.w3.0org/TR/xmlschema-0)
+ Part 1 (https://www.w3.0org/TR/xmlschema-1)
+ Part 2 (http://www.w3.0rg/TR/xmlschema-2)

XML (https://www.w3.org/XML/)

WSDL (https://www.w3.org/TR/wsdl)

*

*

Overview

The GroupWise Web Services object model and methods are defined in the XML schemas. Currently,
the GroupWise schemas include:

+ types. xsd, which defines GroupWise Web Services.
+ net hods. xsd, which defines GroupWise Web Services.

+ events. xsd, which defines GroupWise Events and which referencest ypes. xsd.

The GroupWise WSDL and schemas are available in the GroupWise Web Services SDK.

Overview
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We provide you with the schemas and WSDL files. You then decide the specific development
framework you want to use to build GroupWise applications. Each development framework
compiles its own library with the GroupWise schemas and WSDL. Different frameworks have
different levels of support for Web Services. This means that each generated library could have a
different set of bugs.

We tested the SOAP libraries with Java up to and including version 7, and with Microsoft .NET up to
and including version 4.5.

Web Services on a POA

GroupWise Web Services uses SOAP to communicate with the GroupWise POA.

For more details on enabling SOAP on a POA, see “Supporting SOAP Clients” in the GroupWise
Administration Guide.

The protocol is enabled at the post office. You can enable SOAP in the following three ways:

+ “Using ConsoleOne” on page 15
+ “Using the Command Line” on page 15

+ “Using a POA Startup File” on page 15

Using ConsoleOne

To enable SOAP by using ConsoleOne:

1 In ConsoleOne, browse to and right-click the POA object, then click Properties.
2 Click GroupWise > Agent Settings.
3 Select Enable SOAP.

Using the Command Line

To enable SOAP through the command line, add / soap- enabl ed to the command line, so that the
line reads:

gwpoa @ol. PQA /soap-enabl ed

Using a POA Startup File

To enable SOAP using the startup file:
1 Open the POA startup file and find the following line:
; / soap- [ di sabl ed| Enabl ed]
2 In the configuration file, change the line to read:

/ soap- Enabl ed

Overview 15
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SOAP Requests

GroupWise POAs accept SOAP requests using a URL. Request URLs look like the following:
http://[I P address]:port/soap or https://[IP address]: port/soap
http

HTTP is the GroupWise Web Service transport protocol and appears as it does when accessing a
URL in a browser.

https
HTTPS is the secure GroupWise Web Service transport protocol. In order to use HTTPS (SSL),
each POA needs to have SSL connections enabled for SOAP.

IP address
The IP address is the DNS name or the actual IP address of the POA.

Port
The default port for GroupWise Web Services (SOAP) is 7191. This port can be changed.

/soap

Tells the POA to process the HTTP request as a SOAP request. For example, you could access a
test POA with SOAP by using http://172.16.5.18:7191/soap.

In the HTTP headers, you should be familiar with the soapaction and contenttype headers.

soapaction

The soapaction HTTP header field can be used to indicate the intent of the SOAP HTTP request.
Soapaction is required. However, it does not need to have a value.

contenttype

The contenttype HTTP header field indicates the media type of the entity body that was sent to
the recipient. The value of the contenttype header should be text/xml or application/soap+xml.
This field value is required.

Requests support only a charset of UTF-8. Responses return only a charset of UTF-8. Any other
charset that is passed to the POA is ignored.

The following is an example of an HTTP header:

<HTTPHeader s>

<soapact i on>"f Request " </ soapacti on>
<content-type>text/xm; charset="UTF-8"</content-type>
<user - agent >SOAP Tool kit 3. 0</user-agent >

<host >172. 16. 5. 18: 8080</ host >

<cont ent - | engt h>560</ cont ent - | engt h>

<connect i on>Keep- Al i ve</ connecti on>
<cache-control >no- cache</ cache-control >

<pr agma>no- cache</ pr agma>

</ HTTPHeader s>

The following is an example of a HTTP response header:
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<HTTPHeader s>

<dat e>Thu, 31 Aug 2012 17:51:26 GVI</date>
<server>W ndows G oupW se POA 12.0.0</server>
<content-type>text/xm ; charset=utf-8</content-type>
<cont ent - | engt h>71542</ cont ent - | engt h>

<pr agma>no- cache</ pr agma>

</ HTTPHeader s>

Custom Fields on GroupWise Items

If you want to add application-specific data to items in the GroupWise store, you can do this with
custom fields. For example, if application X wanted to track the items it created in a user’s data store,
application X could add a custom field with a value of X to all items it creates. Later, the application
can use filters to find application X's items.

When a custom field is added to an item, the new custom field definition is added to the GroupWise
post office database. If the post office database has too many custom fields, POA performance can
be reduced. We recommend that the number of custom fields be kept to a minimum and that
applications use no more than two or three custom fields.

To list the custom field definitions on a post office, call getCustomListRequest, which returns the list
of custom fields without any associated values.

To remove a custom field definition in the post office database, call
removeCustomDefinitionRequest. Because the custom field needs to be removed from the items
before the definition can be removed from the post office guardian database, this method can take
some time to process.

You can add a custom fields to new or existing items, You can also modify existing custom fields.
Custom fields can be string, date, numeric, or binary data.

To create custom fields on new items, you need to specify the custom fields in the sendltemRequest
(or createltemRequest) as in the following example:

<ns0: sendl t emrRequest >
<ns0:item xm ns: ans1l="http://schenmas. novel | . com 2005/ 01/ G oupW se/
types"xsi:type="ansl: Mail ">
<ansl:versi on>0</ansl: versi on>
<ansl: custons>
<ansl:customtype="String">
<ansl:fiel d>custonFi el d1</ansl:fiel d>
<ansl:val ue>StringVal ue</ ansl: val ue>
</ ansl: cust om>
</ ansl: cust ons>

You can add a custom field to an existing posted or distributed item with the ModifyltemRequest.
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<nsO0: nodi fyl t enRequest >

<ns0: i d>48F60187. donai nl. pol. 100. 16A6163. 1. 138B. 1@L: 7. donmi nl. pol. 100. 0. 1.
0.1@L6</ ns0:id>

<ns0: updat es>

<ansl:update xm ns:ansl="http://schenas. novel|.conl 2005/ 01/ G oupW se/
types"xsi:type="ansl: Mail ">

<ansl:versi on>0</ansl: versi on>

<ansl: custons>

<ansl:customtype="String">

<ansl:fiel d>custonFi el d2</ansl:fiel d>

<ansl:val ue>Stri ngVval ue2</ ansl: val ue>

</ ansl: cust onp

</ ansl: cust ons>

</ ans1: updat e>

</ ns0: updat es>

</ ns0: nodi fyl t enRequest >

You can also modify an existing custom field by passing in the name of the custom field with the new
value.

<nsO0: modi fyl t enRequest >

<ns0: i d>48F60187. domai nl. pol. 100. 16A6163. 1. 138B. 1@l: 7. donai nl. pol. 100. 0. 1.
0.1@6</ns0:id>

<ns0: updat es>

<ansl:update xm ns:ansl="http://schenmas. novell.com 2005/ 01/ G oupW se/
types"xsi:type="ansl: Mail ">

<ansl:versi on>0</ansl: versi on>

<ansl:custonms>

<ansl:customtype="String">

<ansl:fiel d>custonFi el di</ansl:fiel d>

<ansl:val ue>New String Val ue</ansl: val ue>

</ ansl: cust o>

</ ansl: cust oms>

</ ansl: updat e>

</ ns0: updat es>

;)ﬁso:nodifyltenRequest>

All Day Events and Time Zones

GroupWise all day events can cause problems if applications need to apply the sender's time zone to
the start and end dates.

Problem

An application displays an all day event on the wrong day.

Solution

GroupWise clients set the startDate and endDate to midnight of the user's time zone. As the
item is saved to the user's database, all times are converted to UTC. This causes problems in
determining the actual date of the all day event because the date and time on the event shifts.
The shift depends the time zone of the GroupWise clients.
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As an example, suppose a GroupWise client sends an all day event on 9/26/2012 with a time zone of
Mountain Daylight Time. The output for this all day event is as follows:

<get | t enResponse>
<item type="Appoi nt nent" >

<subj ect >Al | Day Event </subject>

<start Dat e>2012- 09- 26T06: 00: 00Z</ st ar t Dat e>
<endDat €>2012- 09- 27T06: 00: 00Z</ endDat e>
<start Day>2012- 09- 26</ st art Day>
<endDay>2012- 09- 27</ endDay>

<al | DayEvent >1</ al | DayEvent >

<ti mezone>

<dayl i ght >

<nanme>Mbount ai n Dayl i ght Ti me</ nanme>

<mont h>4</ nont h>

<dayOf Week occurrence="First">Sunday</ dayCf Week>
<hour >2</ hour >

<m nut e>0</ m nut e>

<of f set >- 21600</ of f set >

</ dayl i ght >

<st andar d>

<name>Mount ai n Standard Ti ne</ nane>

<nont h>10</ mont h>

<dayOf Week occurrence="Last">Sunday</ dayCOf Week>
<hour >2</ hour >

<m nut e>0</ m nut e>

<of f set >- 25200</ of f set >

</ st andar d>

</timezone>

</itenp

In the output above, the startDate has a value of <st ar t Dat €>2012- 09- 26T06: 00: 00Z</
st art Dat e>. The time is 6:00 a.m. because GroupWise saves the time in UTC. UTC is 6 hours ahead
of MDT in our example.

In order to determine the real date of the all day event, you need to change the startDate and
endDate to midnight by using a time zone to represent the sender’s time zone. An application adds
the sender’s time zone offset to the startDate and endDate values.

Using the example above, this appears as follows:

<st art Dat e>2012- 09- 26T06: 00: 00Z</ st art Dat e> + <of f set >-21600</ of fset> =
<st art Dat e>2012- 09- 26 T00: 00: 00Z</ st ar t Dat e>

The adjusted startDate is midnight. The endDate needs the same adjustment.

AllDayEvents returns a startDate, startDay, endDate, and endDay. The startDate and endDate have
times associated with the dates, as follows:

<startDat e>2012- 09- 26T06: 00: 00Z</ st ar t Dat e>
StartDay and endDay do not have time associated with the dates:

<start Day>2012- 09- 26</ st art Day>
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Use the elements that don't return a time. If an all day event does not interact with other GroupWise
or third-party clients, the startDay and endDay elements can be used. Otherwise, you need to use
the adjusted startDate and endDate elements.

Debugging Tips

Capturing and viewing SOAP/XML data on the wire is a good way to debug problems. There are two
ways to capture SOAP/XML data:

*

Microsoft provides a debugging trace tool with the SOAP Toolkit 3. It allows you to view the
SOAP and XML requests and responses between clients and servers. However, the XML data can
be viewed only if SSL is disabled. To download this trace utility, see Microsoft’s Web site (http://
www.microsoft.com/downloads/details.aspx?Familyld=C943C0ODD-CEEC-4088-9753-
86F052EC8450&displaylang=en#overview). This trace utility executable is called

MsSoapT3. exe. The toolkit is a precursor to .NET. The trace utility runs only on Windows, but
there are other trace utilities that accomplish the same thing.

You can also set the gwTrace element in each request to True. If gwTrace is True, the request
and response are written to the POA log directory. This is a good way to view request and
responses that are encrypted with SSL. The files take on the format of dat exm . 001. For
example, a request response might have a file name of 1006xm . 001. It is a good idea to clean
up the temporary files.

To view the GroupWise Web Service method calls in the POA log files, change the POA log level to
Diagnostic. The user and the method are logged this way. If the POA is in normal or verbose mode,
only the login and logout methods are written to the log files.

Trace Utilities

The following utilities are useful for monitoring the data flowing on a TCP connection:

*

*

tcpmon (http://code.google.com/p/tcpmon)
TcpTrace (http://www.pocketsoap.com/tcpTrace)

Free/Busy

Free/busy information is a real-time view of calendar free/busy time for a set of users. The free/busy
time is returned in blocks of time. Each block of time has an associated acceptLevel of free, busy,
tentative, or out of the office.

There are three methods used in retrieving free/busy time:

*

*

*

Overview

startFreeBusySessionRequest, which creates a server-side object to gather free/busy
information for a set of users with a start and end date.

closeFreeBusySessionRequest, which destroys the server-side object and should be called when
a free/busy search is complete.

getFreeBusyRequest, which retrieves the free/busy blocks for the users provided in the
startFreebusySessionRequest.


http://www.microsoft.com/downloads/details.aspx?FamilyId=C943C0DD-CEEC-4088-9753-86F052EC8450&displaylang=en#overview
http://code.google.com/p/tcpmon
http://www.pocketsoap.com/tcpTrace

Because of the real-time lookup, it might take time to gather free/busy blocks for users on different
post offices. In the getFreeBusyResponse, there is a freebusystats element, which returns the total
number of users in the free/busy call. It also returns the number of users that have responded with
free/busy information and the number of outstanding users that have not returned busy/free
information yet. You might need to call getFreeBusyRequest more than one time to retrieve all the
free/busy time for the list of users. If a user has proxy rights to a user, the subject is returned in the
free/busy block.

In the following example, startFreeBusySessionRequest provides a list of users and a start and end
date for the free/busy search. The startFreeBusySessionResponse returns a freeBusySessionld,
which identifies the server-side free/busy. The freeBusySessionld needs to be passed in as a
parameters to both the getFreeBusyRequest and the closeFreeBusySessionRequest.

<start FreeBusySessi onRequest >
<user s>
<user >
<di spl ayNanme>u2</ di spl ayNanme>
<emai | >u2@hant om conx/ ensi | >
<uui d>42F9A600- 175B- 0000- 890F- 6EO0D5004E00</ uui d>
</ user >
<user >
<di spl ayName>FI RST01010000 LAST01010000</ di spl ayNane>
<emai | >USER01010000@hant om conx/ emai | >
<uui d>07B4A660- 18CA- 0000- B989- BAOOEBOOODOO</ uui d>
</ user>
</ user s>
<start Dat €>20121009T060000Z</ st ar t Dat e>
<endDat €>20121030T060000Z</ endDat e>
</ st art FreeBusySessi onRequest >

<start FreeBusySessi onResponse>
<f reeBusySessi onl d>4250</ f r eeBusySessi onl d>
<stat us>
<code>0</ code>
</ status>
</ start FreeBusySessi onResponse>

In the following request, one user out of two has responded. The freeBusylnfo element returns the
blocks of free/busy time for the one user. You might want to wait up to a minute to call
getFreeBusyRequest to get the free/busy time for the second user.

<get Fr eeBusyRequest >
<f reeBusySessi onl d>4250</ f r eeBusySessi onl d>
</ get Fr eeBusyRequest >
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<get Fr eeBusyResponse>
<freeBusySt at s>
<r esponded>1</responded>
<out st andi ng>1</ out st andi ng>
<total >2</total >
</ freeBusySt at s>
<freeBusyl nf 0>
<user >
<emai | >u2@hant om conx/ eni | >
<uui d>42F9A600- 175B- 0000- 890F- 6E00D5004E00</ uui d>
<bl ocks>
<bl ock>
<start Dat e>2012- 10- 09T06: 00: 00Z</ st ar t Dat e>
<endDat €>2012- 10- 09T14: 00: 00Z</ endDat e>
<accept Level >Busy</ accept Level >
</ bl ock>
<bl ock>
<startDat e>2012- 10-27T23: 00: 00Z</ st ar t Dat e>
<endDat €>2012- 10- 30TO7: 00: 00Z</ endDat e>
<accept Level >Qut O O fi ce</ accept Level >
</ bl ock>
</ bl ocks>
</ user>
</ freeBusyl nf o>
<st at us>
<code>0</ code>
</status>
</ get Fr eeBusyResponse>

To destroy the server-side free/busy session, call closeFreeBusySessionRequest.

<cl oseFr eeBusySessi onRequest >
<f reeBusySessi onl d>4250</ f r eeBusySessi onl d>
</ cl oseFr eeBusySessi onRequest >

<cl oseFr eeBusySessi onResponse>
<stat us>
<code>0</ code>
</ status>
</ cl oseFr eeBusySessi onResponse>

Starting with GroupWise 8.0 SP3, external users are not included in the list of free/busy users. The
startFreeBusySessionRequest returns the users that are external in the problems element.
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<?xm version="1.0" encodi ng="UTF-8" standal one="no"?>
<SQAP- ENV: Envel ope
xm ns: SOAPSDK1="ht t p: // www. w3. or g/ 2001/ XM_Schema"
xm ns: SOAPSDK2="ht t p: / / www. W3. or g/ 2001/ XM_Schena- i nst ance"
xm ns: SOAPSDK3="ht t p: / / schenas. xnl soap. or g/ soap/ encodi ng/ "
xm ns: SOAP- ENvV="ht t p: / / schenas. xrml soap. or g/ soap/ envel ope/ " >
<SOAP- ENV: Header SOAP- ENV: encodi ngStyl e="">
<sessi on>XVN | FPCVRwvr ED</ sessi on>
</ SOAP- ENV: Header >
<SOAP- ENV: Body SQAP- ENV: encodi ngSt yl e="">
<start FreeBusySessi onRequest >
<user s>
<user >
<di spl ayNanme>Pr est on St ephenson</ di spl ayNane>
<emai | >Pr est on. St ephenson@ryhost . conx/ enai | >
</ user>
<user >
<di spl ayNanme>Pr est on St ephenson</ di spl ayNane>
<emui | >pst ephenson@r est ons. provo. novel | . conx/ emai | >
<uui d>2D16B180- 0922- 0000- 846C- 82BD300F9E1C</ uui d>
</ user>
</ users>
<startDate>20110119T070000Z</ st ar t Dat e>
<endDat €>20110209T070000Z</ endDat e>
</ st art Fr eeBusySessi onRequest >
</ SOAP- ENV: Body>
</ SOAP- ENV: Envel ope>

<?xm version="1.0" encodi ng="UTF-8"7?>
<SQOAP- ENV: Envel ope
xm ns: SOAP- ENV="htt p: // schenas. xm soap. or g/ soap/ envel ope/ "
xm ns: SOAPSDK3="htt p:// schenas. xm soap. or g/ soap/ encodi ng/ "
xm ns: SOAPSDK2="ht t p: / / www. w3. or g/ 2001/ XM_Schena- i nst ance"
xm ns: SOAPSDK1="htt p: / / www. w3. or g/ 2001/ XM_Schema" >
<SCAP- ENV: Header SOAP- ENV: encodi ngStyl e=""/>
<SOAP- ENV: Body SQAP- ENV: encodi ngSt yl e="">
<start FreeBusySessi onResponse>
<freeBusySessi onl d>154702</ f r eeBusySessi onl d>
<st at us>
<code>0</ code>
<pr obl ens>
<entry>
<el enent >Pr est on. St ephenson@ryhost . conx/ el enent >
<code>53505</ code>
<descri ption>User not on post office</description>
</entry>
</ probl ems>
</ status>
</ st art Fr eeBusySessi onResponse>
</ SOAP- ENV: Body>
</ SOAP- ENV: Envel ope>
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NOTE: The ProblemEntry only has one element entry. The value that is put in the element entry is
from the user element from the request. The order of the value to add is the email, displayName,
then uuid element values.

Starting in GroupWise 2012, the external email addresses are dropped by default. There are two
optional attributes that can be put on the FreeBusyUserList element: external and
externalGroupWise.

If 1 ort r ue is passed for the value of the attribute, the external email address is passed in the free/
busy search.

The external attribute passes in all external users. The externalGroupWise attribute only passes
GroupWise users that are in external domains.

Getting Items

There are different ways to retrieve items from a GroupWise container. Each of these methods has
an input parameter of a container. A container is an abstract wrapper of GroupWise items. A
container can be a GroupWise folder, address book, or library.

There are special strings to use as the container ID. The folders attribute can be used to search over
all folders in the user’s mailbox. (This searches all of the folders with the exception of shared folders
shared with the user, query folders and the Trash folder.) The books attribute can be used to search
over all personal address books.

This section contains the following sections:

+ “Get Items Request” on page 24
+ “GroupWise Cursors” on page 26

+ “Stubbed Items” on page 32

Get Items Request

getltemsRequest can retrieve items from folders, query folders, shared folders, personal address
books, the GroupWise Address Book, libraries, document versions, and document version events.

NOTE: If you are getting more than 20 items, you should use the cursor request, as described in
GroupWise Cursors.

For GroupWise 2012 and later:

There are times when you have an item id, but you don’t know what container the item is in. You can
use getltemsRequest to return the item. You pass the id value in an <item> element of the <items>
element. You pass f ol der s or books as the container.
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<get | t ensRequest >
<cont ai ner >f ol der s</ cont ai ner >
<view>i d status subject startDate created</vi ew
<itens>
<i temP4E92DD25. domai n. POL. 100. 1776172. 1. 454BF. 1</i tem>
</itens>
</ get | t ensRequest >

If you have a sid, you can pass that. (You must also pass si d in the view, so the code knows the value
is sid and not an id.)

<get | t ensRequest >
<cont ai ner >f ol der s</ cont ai ner >
<view>id sid status subject startDate created</view>
<itens>
<i temr283839</ansl:itenp
</itens>
</ get | t ensRequest >

On folder items, using f ol der s as the container, the code cannot find the item in a shared folder
shared with the user. On personal address books, the code can find the item even in personal
address books shared with the user.

When you have events, the event sometimes does not include what container the itemis in. There is
a special formatted id you can use to quickly read the item. For example, if you have the following
event:

event > t emvbdi f y</ event >
<i d>4E9D1539. donai n. POL. 100. 1776172. 1. 46167. 1</i d>
<si d>287079</ si d>
<timeStanp>2011- 10- 18T12: 16: 24Z</ti meSt anp>
<fiel d>MessageBody Subject</field>
<key>t est </ key>
<ui d>868965</ ui d>
<type>Mi |l </ type>
</ event >

Then you combine the <id> and the <uid> values to generate an id:
4E9D1539. donai n. POL. 100. 1776172. 1. 46167. 1@vent : 868965

You pass this id in the <item> element. The code can quickly verify the user has the right to read the
item.

NOTE: The event record must still exist in this case. The code uses the event record to verify that the
user has access to the item. If the event record is already deleted, this method of getting the item
fails.

<get | t ensRequest >
<cont ai ner >f ol der s</ cont ai ner >
<view>i d status subject startDate created</vi ew>
<itens>
<i temP4E9D1539. domai n. POL. 100. 1776172. 1. 46167. 1@vent : 868965</i t em>
</itens>
</ get | t ensRequest >
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GroupWise Cursors

GroupWise cursors provide you with a method to retrieve large amounts of container data in
chunks. Cursors can be used to retrieve a subset of items with subsequent methods instead of
getting all the items in one response. For example, suppose a user has 1,000 items in a folder and
you retrieve 100 items per call. To retrieve all 1,000 items would mean calling a method 10 different
times.

Cursors also provide you with the ability to read items from the start or end of a list. For example,
there is a container with 1000 items. Item 1 is the start of the list and item 1000 is the end of the list.
You can use cursors to read items from the start to the end of the list (item 1 to item 1000), or you
can use cursors to read items from the end to the start of the list (item 1000 to item 1).

GroupWise cursors require the use of several methods. The methods are:

+ createCursorRequest, which creates a cursor on the server where the new cursor is a pointer to
the container data.

+ readCursorRequest, which reads the data from the container.
+ positionCursorRequest, which sets the position of the cursor on the server.

+ destroyCursorRequest, which removes the cursor from the server.

A cursor has an anchor position in the list of items. The anchor position can be the start of the list,
the current position in the list, or the end of the list. The readCursorRequest and
positionCursorRequest method can position the anchor in the list. For example, there is another
container with 1,000 items, with item 1 at the start position and item 1,000 at the end position. As
you read items by calling readCursorRequest, the cursor position moves. If you read 100 items with
readCursorRequest, the anchor position of the cursor is 101. The next time you call
readCursorRequest, reading starts at item 101 if the position elementiscurrent.

readCursorRequest has a forward element. If the forward element is True, readCursorRequest reads
from the starting anchor position to the ending anchor position. If the forward element is False,
readCursorRequest reads from the ending anchor position to the starting anchor position.

Cursor data can become stale. For example, you create a cursor that points to a folder. If an item is
added to the folder after the cursor is created, it does not return the new item by calling
readCursorRequest. You need to create a cursor, read the data, and then close or destroy the cursor.

Consider the following when working with GroupWise cursors:

+ You can create more than one cursor per logged-in user.

NOTE: Do not create a large number of cursors per user, because it creates overhead that might
degrade your system’s performance.

+ You can use cursors on folders, shared folders, personal address books, and the GroupWise
Address Book.

+ You cannot use cursors on contact folders or query folders.

+ You cannot use cursors to get documents from a library.
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For example, you cannot use cursors to get documents from the Authored Library or the Default
Library.

Using cursors to read the Documents folder returns document references only; it does not
return the documents themselves. Use streamedSearchRequest on document libraries in the
place of cursors.

If a container does not support cursors, the following error is returned:

<creat eCur sor Response>

<stat us>

<code>59916</ code>

<descri ption>The nethod called is not supported.</description>
</ st at us>

</ creat eCur sor Response>

Cursor Examples

This section contains the following examples:

+ “readCursorRequest (forward)” on page 27
+ “readCursorRequest (backward)” on page 29
+ “positionCursorRequest (backward)” on page 30

+ “createCursorRequest” on page 31

readCursorRequest (forward)

In the following example, readCursorRequest returns items in order of oldest to newest. The
container is the Mailbox. The forward element is Tr ue, and the position element is cur r ent . Five
items are returned because the count element is set to 5.

The first call to readCursorRequest returns items 1 to 5.

<r eadCur sor Request >
<cont ai ner >7. donai nl. pol. 100. 0. 1. 0. 1@6</ cont ai ner >
<cur sor>1186833449</ cur sor >
<f or war d>t r ue</ f or war d>
<posi tion>current </ position>
<count >5</ count >
</ r eadCur sor Request >

<r eadCur sor Response>
<itens>

<itenp

<i d>450AB7Cl. domai nl. pol. 100. 16E3837. 1. FDO. 1@l: 7.
donmi nl. pol.100.0.1.0.1@6</id>

<nmodi fi ed>2012- 09- 15T22: 23: 28Z</ nodi fi ed>
<cont ai ner >7. domai nl. pol. 100. 0. 1. 0. 1@L6</ cont ai ner >
<sour ce>r ecei ved</ sour ce>
<subj ect >1</ subj ect >

<litemp
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.items 2, 3, and 4

<itenp

<i d>450AB7EA. domai nl. pol. 100. 16E3837. 1. FD8. 1@.: 7
domai nl. pol.100.0. 1. 0.1@6</id>

<nmodi fi ed>2012- 09- 15T22: 23: 28Z</ nodi fi ed>

<cont ai ner >7. domai nl. pol. 100. 0. 1. 0. 1@6</ cont ai ner >

<sour ce>r ecei ved</ sour ce>

<subj ect >5</ subj ect >

<litenr
<litens>
<stat us>
<code>0</ code>
</ status>

</ readCur sor Response>

The next call to readCursorRequest returns items 6-10.

<r eadCur sor Request >

<cont ai ner >7. donai nl. pol. 100. 0. 1. 0. 1@.6</ cont ai ner >
<cur sor>1186833449</ cur sor >

<f or war d>t r ue</ f or war d>

<posi tion>current </ position>

<count >5</ count >

</ readCur sor Request >

<r eadCur sor Response >

<items>
<itemnp

<i d>450AD389. domai nl. pol. 100. 16E3837. 1. 1002. 1@l: 7.
domai nl. pol.100.0.1.0.1@6</id>

<nodi fi ed>2012- 09- 19T19: 26: 27Z</ nodi f i ed>

<cont ai ner >7. domai nl. pol. 100. 0. 1. 0. 1@L6</ cont ai ner >

<sour ce>r ecei ved</ sour ce>

<subj ect >6</ subj ect >

</itenp

.itenms 7, 8, and 9

<itemnp

<i d>450AD3A8. domai nl. pol. 100. 16E3837. 1. 100A. 1@l: 7.
domai nl. pol.100.0. 1. 0.1@6</id>

<nodi fi ed>2012- 09- 19T19: 26: 29Z</ nodi f i ed>

<cont ai ner >7. domai nl. pol. 100. 0. 1. 0. 1@L6</ cont ai ner >

<sour ce>r ecei ved</ sour ce>

<subj ect >10</ subj ect >

<litenp
<litens>
<st at us>
<code>0</ code>
</ status>

</ readCur sor Response>
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readCursorRequest (backward)

In the following example, readCursorRequest returns items in order of newest to oldest. The

container is the Mailbox. The forward element is Fal se, and the position element is end. Five items

are returned because the count element is set to 5.
The first call to readCursorRequest returns items 25 to 21.

<r eadCur sor Request >
<cont ai ner >7. domai nl. pol. 100. 0. 1. 0. 1@6</ cont ai ner >
<cursor>1186833450</ cur sor >
<f orwar d>f al se</ f orwar d>
<posi ti on>end</ posi ti on>
<count >5</ count >
</ readCur sor Request >

<r eadCur sor Response>
<itens>
<itene
<i d>450AD40A. domai nl. pol. 100. 16E3837. 1. 1028. 1@l: 7.
domai nl. pol.100.0. 1. 0.1@6</id>
<nodi fi ed>2012- 09- 19T19: 26: 36Z</ nodi fi ed>
<cont ai ner >7. domai nl. pol. 100. 0. 1. 0. 1@L6</ cont ai ner >
<sour ce>r ecei ved</ sour ce>
<subj ect >25</ subj ect >
<litemp
.itenms 24, 23, and 22
<itenmp
<i d>450AD3F2. donmi nl. pol. 100. 16E3837. 1. 1020. 1@L: 7.
domai nl. pol.100.0.1.0.1@6</id>
<nodi fi ed>2012- 09- 19T19: 26: 34Z</ nodi fi ed>
<cont ai ner >7. domai nl. pol. 100. 0. 1. 0. 1@6</ cont ai ner >
<sour ce>r ecei ved</ sour ce>
<subj ect >21</ subj ect >
<litemp
</itens>
<st at us>
<code>0</ code>
</ status>
</ readCur sor Response>

The next call to readCursorRequest returns items 20 to 16.

<r eadCur sor Request >
<cont ai ner >7. domai nl. pol. 100. 0. 1. 0. 1@.6</ cont ai ner >
<cur sor>1186833450</ cur sor >
<f or war d>f al se</ f or war d>
<posi ti on>current </ position>
<count >5</ count >
</ r eadCur sor Request >
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<r eadCur sor Response>
<itens>
<itemp
<i d>450AD3EB. donmi nl. pol. 100. 16E3837. 1. 101E. 1@.: 7.
domai nl. pol.100.0.1.0.1@6</id>
<nmodi fi ed>2012- 09- 19T19: 26: 34Z</ nodi fi ed>
<cont ai ner >7. domai nl. pol. 100. 0. 1. 0. 1@6</ cont ai ner >
<sour ce>r ecei ved</ sour ce>
<subj ect >20</ subj ect >
<litenp
.items 19, 18, and 17
<itemp
<i d>450AD3D4. donmi nl. pol. 100. 16E3837. 1. 1016. 1@L: 7.
domai nl. pol. 100.0.1.0.1@6</id>
<modi fi ed>2012- 09- 19T19: 26: 32Z</ nodi fi ed>
<cont ai ner >7. domai nl. pol. 100. 0. 1. 0. 1@6</ cont ai ner >
<sour ce>r ecei ved</ sour ce>
<subj ect >16</ subj ect >
<litenp
</itens>
<st at us>
<code>0</ code>
</ status>
</ readCur sor Response>

positionCursorRequest (backward)

NOTE: The positionCursorRequest method can produce unexpected results. Instead of using this
method, we recommend that you use readCursorRequest to read from the beginning or the end.

In the following example, positionCursorRequest positions the anchor at the end of the list with an
offset of 5. The list end is item 25. Taking into account the offset from the end of the list, the anchor
position is at item 20. readCursorRequest moves backward in the list because the forward element is
Fal se, and the position element is cur r ent , which means to start the read at the current anchor
position of 20.

<posi ti onCur sor Request >
<cont ai ner >7. donai nl. pol. 100. 0. 1. 0. 1@6</ cont ai ner >
<cur sor>1186833452</ cur sor >
<seek>end</ seek>
<of f set >5</ of f set >
</ posi ti onCur sor Request >

<r eadCur sor Request >
<cont ai ner >7. donai nl. pol. 100. 0. 1. 0. 1@6</ cont ai ner >
<cursor>1186833452</ cur sor >
<f or war d>f al se</ f or war d>
<posi tion>current </ position>
<count >5</ count >
</ readCur sor Request >
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<r eadCur sor Response>
<itens>
<itemp
<i d>450AD3EB. donmi nl. pol. 100. 16E3837. 1. 101E. 1@.: 7.
domai nl. pol.100.0.1.0.1@6</id>
<nmodi fi ed>2012- 09- 19T19: 26: 34Z</ nodi fi ed>
<cont ai ner >7. domai nl. pol. 100. 0. 1. 0. 1@6</ cont ai ner >
<sour ce>r ecei ved</ sour ce>
<subj ect >20</ subj ect >
<litenp
.items 19, 18, and 17
<itemp
<i d>450AD3D4. donmi nl. pol. 100. 16E3837. 1. 1016. 1@L: 7.
domai nl. pol.100.0.1.0.1@6</id>
<modi fi ed>2012- 09- 19T19: 26: 32Z</ nodi fi ed>
<cont ai ner >7. domai nl. pol. 100. 0. 1. 0. 1@6</ cont ai ner >
<sour ce>r ecei ved</ sour ce>
<subj ect >16</ subj ect >
<litenp
</itenms>
<stat us>
<code>0</ code>
</ status>
</ readCur sor Response>

createCursorRequest

The following example demonstrates creating a cursor with a filter and a view by calling
createCursorRequest. The view specifies the elements that should be returned for each item in the
request. The filter narrows the items that are read in the user's database. The following filter
indicates to read items with a created date that is greater than 2012-08-13.

<creat eCur sor Request >
<cont ai ner >7. donai nl. pol. 100. 0. 1. 0. 1@6</ cont ai ner >
<vi ew>nodi fi ed subject </ vi ew>
<filter>
<el ement type="FilterEntry">
<op>gt </ op>
<field>created</field>
<val ue>2012- 08- 13T00: 00: 00Z</ val ue>
</ el enent >
</filter>
</ cr eat eCur sor Request >
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<r eadCur sor Request >
<cont ai ner >7. domai nl. pol. 100. 0. 1. 0. 1@6</ cont ai ner >
<cursor>1188933747</ cursor >
<f orwar d>t r ue</ f or war d>
<posi tion>start</position>
<count >5</ count >
</ readCur sor Request >

<r eadCur sor Response>
<itens>
<itemp
<i d>450AB7CLl. domai nl. pol. 100. 16E3837. 1. FDO. 1@.: 7
domai nl. pol. 100.0. 1. 0. 1@6</id>
<modi fi ed>2012- 09- 15T22: 23: 28Z</ nodi fi ed>
<cont ai ner >7. domai nl. pol. 100. 0. 1. 0. 1@6</ cont ai ner >
<sour ce>r ecei ved</ sour ce>
<subj ect >1</ subj ect >
<litenp
</itens>
<st at us>
<code>0</ code>
</ status>
</ readCur sor Response>

Stubbed Items

You can search on the statusExt field to find stubbed items. The values you can pass in the filter for
the statusExt field are:

+ stubbed (thirdParthStubbed)
+ downloaded (thirdPartyDownloaded)
+ archived (thirdPartyArchive)

The following example searches for stubbed items:
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<get | t ensRequest >

<cont ai ner >4E2E7543. donmi n. POL. 100. 1646A30. 1. 44. 1@.3</ cont ai ner >

<vi ew>def aul t st ubbed</vi ew>
<filter>
<el ement >
<op>and</ op>
<el ement >
<op>i sOf </ op>
<field>statusExt</field>
<val ue>st ubbed</ val ue>
</ el ement >
<el enent >
<op>exi st s</ op>
<field>statusExt</field>
<val ue>0</ val ue>
</ el ement >
</ el ement >
</filter>
</ get |t ensRequest >

NOTE: You must search for the existence of the statusExt field and the stubbed value being set or

you get false positive matches.

HTTP Connections

GroupWise Web Services is based on HTTP as the transport layer. HTTP 1.1 provides persistent
connections to the POA. The <connect i on>keep- al i ve</ connect i on> line establishes this

persistent connection. If the connection is not used, it times out after 30 minutes of inactivity. Most
development frameworks reestablish the connection for an application after the timeout. You

should test your application to ensure that it behaves correctly after a timeout.

There is also a SOAP session connection. This session is a GroupWise connection to the POA. The
session times out after 30 minutes. If your application needs to keep this GroupWise session alive,
the getTimestampRequest method provides a noop parameter. The noop option keeps the session

and HTTP connections open.

The following is an example of HTTP headers in a login request and response:
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<HTTPHeader s>
<content-type>text/xm ; charset=utf-8</content-type>
<cont ent - | engt h>809</ cont ent - | engt h>
<soapact i on>"| ogi nRequest "</ soapacti on>
<user-agent >Java/ 1. 5. 0_04</ user - agent >
<host >137. 65. 15. 37: 8080</ host >
<accept>text/htm, image/gif, inmage/jpeg, *; Q= 2,
*[*:. g=. 2</ accept>
<connect i on>keep-al i ve</ connecti on>
</ HTTPHeader s>

<HTTPHeader s>
<dat e>Tue, 10 Cct 2012 12:01:19 GVI</date>
<server >W ndows G oupW se PQA 7.0. 1</server>
<content-type>text/xm; charset=utf-8</content-type>
<cont ent - | engt h>940</ cont ent - | engt h>
<pr agma>no- cache</ pragma>

</ HTTPHeader s>

Message Bodies

Message bodies can be in the following formats:

+ Plain text (no formatting is embedded in the file)
+ RTF (rich text formatting)
¢ HTML

The following sections describe how to deal with large message bodies and HTML message bodies.

+ “Large Message Bodies” on page 34

+ “HTML Message Bodies” on page 36

Large Message Bodies

To retrieve message bodies, the message keyword should be included in the view. For message
bodies smaller than 32 KB, the message body is returned in the message element itself. For message
bodies greater than 32 KB, a message ID attribute is returned instead of the message body. If a
message ID is returned, call getAttachmentRequest to download the message body.

The following example returned a large message body. The ID is an attribute on the message
element, and the length of the file is just over 1 MB.
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<itens>
<itemtype="Mil">
<i d>452A4D93. donmi nl. pol. 100. 1647535. 1. 635. 1@.: 7.
domai nl. pol. 100.0. 1. 0. 1@6</id>

<subj ect >Large Message Body</subj ect >
<message>
<part content Type="text/plain" |ength="1008596" id="452A4D93.
domai nl. pol. 200. 20000B2. 1. 374. 1@5: 452A4D93. donmmi nl. pol. 100.
1647535. 1. 635. 1@l: 7. domai nl. pol. 100. 0. 1. 0. 1@6" />
</ nessage>
</itemp
</items>
To read the message body, call getAttachmentRequest with the ID of the message body.
getAttachmentRequest allows you to read the message body in chunks by providing an offset and a

length. The offset is the location in the file to start reading. The length is the number of bytes to
read. In the first call to getAttachmentRequest, the offset is 0 and the length is 16 KB.

<get At t achment Request >
<i d>452A4D93. domai nl. pol. 200. 20000B2. 1. 374. 1@5: 452A4D93. domai nl
pol. 100. 1647535. 1. 635. 1@.: 7. donai nl. pol. 100. 0. 1. 0. 1@6</i d>
<of f set >0</ of f set >
<l engt h>16384</ | engt h>
</ get At t achment Request >

In the following example, the offset is an attribute on the part element. In the next call to
getAttachmentRequest, pass in the returned offset value as the offset. The reason the offset can be
different than the length passed in is because message bodies are stored in GroupWise in an internal
format. After you read in the requested amount of data from the GroupWise store, the data is
translated and the size changes.

<get At t achment Response >
<part | ength="16180" offset="16379">
N k3Mzcw\Nk M2MTc5M A2NDZGN) MBNTZEN] U2RTcONz My VD
C5NKY3NTI wi\j g2MTc2N) Uy MDY

EAgRKOMREVSX1IFQO9SRCA=</ par t >
<gwm st at us>
<code>0</ code>
</ status>
</ get At t achment Response>

The next time getAttachmentRequest is called, it looks like the following example. The offset on the
call matches the offset returned in the last getAttachmentResponse.

<get At t achment Request >
<i d>452A4D93. donai nl. pol. 200. 20000B2. 1. 374. 1@5: 452A4D93.
domai nl. pol. 100. 1647535. 1. 635. 1@.: 7. domai nl. pol. 100. 0. 1. 0. 1@6</i d>
<of f set >16379</ of f set >
<l engt h>16384</ | engt h>
</ get At t achment Request >

The example above is only for message bodies. Normal attachments return the same offset as the
specified length.
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HTML Message Bodies

Message bodies can be in HTML format. HTML messages are returned as the first attachment and
are named t ext . ht m Any embedded images or associated files are also downloaded as
attachments. These HTML associated files are all marked hidden.

The HTML message body and accompanying files are grouped together. The t ext . ht mfile is first,
followed by the other associated files. Each of the accompanying attachments has a contendld
element. Loop through the attachments until you come to an attachment that does not have a
contentld element or until you come to the end of the attachments. If you want to create an HTML
message body in SOAP, you need to add the attachments in the same order and add the contentld
element for the accompanying files.

In the following example, an item has an HTML message body with an embedded image. The
attachments section contains a t ext . ht mfile. Attachment 2 is an embedded image in the HTML
attachment. Also notice that the message element itself has a message body. This is the attachment
in plain/text format.

<itemtype="Mil">
<i d>452A6054. domai nl. pol. 100. 1647535. 1. 644. 1@l: 7.
domai nl. pol.100.0.1.0.1@6</id>

<message>
<part content Type="text/plain"
| engt h="284">e1xydGYxXGR Znm¥welxn250dGIselxmvFxmbm sX&j
aGFy c2VONMBBUYWhVBWET7f X17XG\Nvb@ydGIsOLxy ZWQy NTVe Z3J | ZWiwX
GIsdWMWOLXYy ZWQy NTVc Z3J1 ZWAwWXGI s dWUWOB1 7 XHNOeWk I c2hl ZXR7XGZz
MIYgR3JvdXBXaXN Vi | dzt 9f VxntzE2l EhUTUngbW/zc2FnZSB3aXRol G-
ul At YWdI LI xwYXI gl FxwYXI gl FxwYXl gQAZ0ZXI gdGhl | HBpY3R1
crmJuXHBhci B9</ part >
</ message>
<attachment s>
<attachnent >
<i d>452A6054. domai nl. pol. 200. 20000B2. 1. 398. 1@5: 452A6054.
domai nl. pol. 100. 1647535. 1. 644. 1@.: 7. domai nl. pol
100.0.1.0.1@6</id>
<nane>Text . ht nx/ nane>
<cont ent Type>TEXT/ HTM_</ cont ent Type>
<si ze>409</ si ze>
<dat e>2012- 10- 09T14: 44: 35Z</ dat e>
<hi dden>1</ hi dden>
</ attachnent >
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<attachnent >
<i d>452A6054. domai nl. pol. 200. 20000B2. 1. 399. 1@5: 452A6054.
domai nl. pol. 100. 1647535. 1. 644. 1@.: 7. domai nl. pol
100.0.1.0.1@6</i d>
<nane>| MAGE. gi f </ nane>
<cont ent | d><UQSTEWRZPCCH. appt . gi f ></ cont ent | d>
<cont ent Type>l| MAGE/ gi f </ cont ent Type>
<si ze>143</si ze>
<dat e>2012- 10- 09T14: 44: 35Z</ dat e>
<hi dden>1</ hi dden>
</ attachnent >
</ attachnent s>

<litenp
To retrieve the HTML message, call getAttachmentRequest with the ID of the t ext . ht mfile. Your
method should look similar to the following:

<get At t achment Request >
<i d>452A6054. donai nl. pol. 200. 20000B2. 1. 398. 1@5: 452A6054.
domai nl. pol. 100. 1647535. 1. 644. 1@.: 7. donmai nl. pol.
100.0.1.0.1@6</id>
</ get At t achment Request >

<get At t achnent Response>
<part | ength="548"
of f set =" 409" >PEhUT Uw+PEh FQUQ+DQu 8 TUVUQSBod HRML WX dW 2PUN
vbnRl bnQ VH wZSB

ERJVj 5BZnRI ci B0aGJgcd j dHVyZS48LORIV] 48L0JPRFk
+PC9I VE1MPg==
</ part>
<stat us>
<code>0</ code>
</ status>
</ get At t achment Response>

The actual HTML message follows. The embedded image below has a src value equal to the
contentld of the second attachment in the preceding example.

<HTM_><HEAD>

<META htt p- equi v=Cont ent - Type content="text/htnl; charset=utf-8">

<META cont ent =" MSHTM_ 6. 00. 2900. 2963" name=GENERATOR></ HEAD>

<BODY style="MARGA N: 4px 4px 1lpx; FONT: 10pt Tahoma">

<Dl V>HTML nmessage with an inage. </ DI V>

<Dl V>&nbsp; </ DI V>

<Dl V><IMG alt="" hspace=0 src="ci d: UQSTEWRZPCCH. appt . gi f" al i gn=basel i ne
bor der =0></ DI V>

<Dl V>&nbsp; </ DI V>
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Proxy

Proxy allows users to share their accounts with other users. For example, userl wants to provide
access to user2 to his or her account. Userl needs to provide access rights to user2. The
createProxyAccessRequest method grants access rights to user2, modifyProxyAccessRequest
modifies the access rights, and removeNotifyRequest removes any previously defined rights.

User2 now wants to proxy into userl's account. The getProxyListRequest method returns the list of
users that user2 has successfully proxied into in the past. If user2 has not successfully proxied into
userl's account in the past, the userl account does not appear in the getProxyListResponse.

For user2 to proxy into userl's account, call the loginRequest method.

Recurrence

GroupWise supports recurring appointments, notes, and tasks. Recurring items are created from
one item that fans out into many items. For example, a manager wants to send out a team
appointment. The appointment occurs every Monday morning at 9:00 a.m. The manager could send
out one appointment for each occurrence, but that would be time-consuming and tedious. Using
GroupWise, the manager can send out one appointment and specify the recurring dates for the
appointment.

This section contains the following examples:

+ “Recurring ltem Example” on page 39
+ “Recurring Daily Appointment Example” on page 39

+ “Recurring ltem with a Rule Example” on page 40

GroupWise Web Services defines recurring items on the Calendarltem element. The recurring
elements are rdate, exdate, and rrule.

The rdate element specifies a list of days to include in the recurrence. The rrule specifies a rule that
defines a list of days to include in the recurrence. The exdate specifies a list of days to exclude in the
recurrence. All three elements (rdate, rrule, and exdate) can be used to build a list of recurring days.

The rrule element defines a rule that defines the number of occurrences for the calendar item.
There are industry standards that deal with recurrence. You should be familiar with recurrence in
RFC 2445. For more information, see 4.3.10 Recurrence Rule (http://www.ietf.org/rfc/rfc2445. txt).

GroupWise supports a subset of the many definitions that are available in recurrence rules. For
example, in rrule there is a frequency element defined in the GroupWise schemas. RFC 2445 defines
Secondly, Minutely, Hourly, Daily, Weekly, Monthly, and Yearly. At this time, GroupWise doesn’t
support Secondly, Minutely, or Hourly. Consult the GroupWise schemas and RFC 2445 to see what
elements are supported.

For each recurring instance, GroupWise creates a new item in the user's database at send time. For
example, suppose an application creates a recurring appointment by calling sendltemRequest. The
appointment defines a recurrence rule. When the POA evaluates the item, it fans out or creates a
new item for each instance defined in the recurrence rule. This fanning out of recurring items is
different than some other collaboration products. Other collaboration products create one instance
of the item and store the recurrence rule with the item.
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When you get a list of calendar items, recurring items are grouped together with a recurrenceKey. If
you want to accept, decline, delegate, or modify all recurring items, pass in the recurrenceKey to the
appropriate method.

If your user base is used to seeing only one calendar item to represent a recurring calendar item, it is
up to the application to collapse the fanned-out items into one item. The recurrenceKey is used to
determine which items are a part of the recurrence group.

Recurring Item Example

In the following example, three appointments are created in the recipient's mailbox by calling
sendltemRequest. The startDate and endDate create one instance, while the rdate element defines
two other instances. The startDate and endDate both have a time associated with the date. This time
value is used to create the duration of the appointment. The rdate values have only a date with no
associated time. The rdate elements use the time and duration specified in the startDate and
endDate elements.

<sendl t enRequest >
<types:itemtype="Appoi nt ment">

<subj ect >Recurrence 1</subject>

<startDat e>20121012T180000z</ st ar t Dat e>
<endDat €>20121012T190000Z</ endDat e>
<r dat e>
<dat €>20121013</ dat e>
<dat €>20121016</ dat e>
</rdate>
<al arm t ypes: enabl ed="1">5</ al ar n>
</types:itenpr
</ sendl t enRequest >

Recurring Daily Appointment Example

In the following example, a recurring item is created on a startDate of 10/12/2012. The rrule element
specifies to create an appointment daily until 10/20/2012.

<sendl t enRequest >
<types:itemtype="Appoi nt nent">
<subj ect >Recurrence 2</subject>
<start Dat e>20121012T180000Z</ st ar t Dat e>
<endDat €>20121012T190000Z</ endDat e>
<rrul e>
<frequency>Dai | y</frequency>
<until >20121020</until >
</rrul e>
<al arm t ypes: enabl ed="1">5</ al ar n>
</types:itenp
</ sendl t enRequest >
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Recurring Item with a Rule Example

In the following example, recurring items are created using this rule:

+ startDate specifies October 12, 2012 at 7:00PM UTC as the start time.
+ endDate specifies October 12, 2012 at 8:00PM UTC as the end time.
+ frequency creates the appointments on a monthly basis.

+ until creates the monthly appointments until 2/28/2013.

+ day creates the appointments only on Mondays.

<startDat e>20121012T190000Z</ st art Dat e>
<endDat €>20121012T200000Z</ endDat e>
<rrul e>

<f requency>Mont hl y</frequency>

<until>20070228</until >

<interval >2</interval >

<byDay>

<day>Monday</ day>

</ byDay>

</rrule>

Redirection

Redirection is used to discover a user's post office address and port. If you try to log in as a user to a
wrong POA, a redirectToHost element is returned in the loginResponse. The redirectToHost element
provides the IP address or DNS name and port of the POA of the user. Your application can retry the
loginRequest to the new IP address and port. It can also cache the correct IP address and port so that
a redirection is not required in the future.

For redirection to work correctly, the SOAP port needs to be configured in ConsoleOne for each POA.
ConsoleOne writes the SOAP port settings to the GroupWise databases. On a redirection attempt,
other POAs can successfully read the settings from the databases. If a POA is configured in a
configuration file or on the command line, other POAs cannot access configuration files or command
line settings. The correct settings must be in the GroupWise databases.

In the following loginRequest example, user po2ul logged into the wrong POA. The loginResponse
returned the correct IP address and port of the user. It also returned error 59923 with a description
stating a redirection is required.

<l ogi nRequest >

<types:auth types: Pl ai nText >

<user nane>po2ul</ user nane>

<passwor d>po2ul</ passwor d>

<aut h/ >

<appl i cati on>BEEPC i ent </ appl i cati on>
</ | ogi nRequest >
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<l ogi nResponse>
<r edi rect ToHost >
<i pAddr ess>137. 65. 15. 37</i pAddr ess>
<port>7192</ port >
</ redirect ToHost >
<status>
<code>59923</ code>
<descri ption>Redirect user to different PQ </description>
</ status>
</l ogi nResponse>

Streaming Attachments

Before using the streaming code, verify that you are logged into a GroupWise 8.0 or later POA. After
a successful login, the loginResponse contains the POA version in the gwversion element.

The streaming functionality is accessible via the following URL:
http(s)://server:port/attachment?session=...&id-=...

+ http or https: HTTP protocol with or without SSL.
+ server: The IP address of the DNS name of the POA server.
+ attachment: The keyword to tell the POA to stream the attachment.
+ session: A valid login session is required.
+ id: The SOAP id of the attachment to be streamed
¢ port: The SOAP port.
There are some additional parameters that can be included in the URL:
+ &plain=1: Returns the document in plain text.

+ &mime=1: Returns the MIME representation (RFC822) of the item. You need to pass in the ID of
the item and not the attachment when getting the MIME representation.

A GroupWise error in streaming the attachment is returned as HTTP status 400. The header line
contains X- GAEr r or - Code = GroupW se Error Code, which specifies the GroupWise error
code.

Sample Java code is given below:

mitem= (Mil)res.getltem);
info = mitemgetAttachnments();
itenms = info.getAttachment();
for (i =0; i <items.length; i++)
{

str = tenp + mgwWhi n. get G oupW seServiceld() + "& d=" +
itens[i].getld().get value();

size = (int)itens[ i ].getSize();

offset = 0;

try

{

URL url = new URL( str );

Ht t pURLConnecti on huc = (Htt pURLConnecti on)url . openConnection();
I nput Streamis = huc. getl nput Stream();
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byte[] b = new byte[ 16384 ];

out = new FileQutputStrean( new File( "c:\\tenp", itens[ i ].getNanme()
) );
Systemout.println( "Start: " + new Date().toString() );
while ( size > 0)

{
len = is.read( b, 0, 16384 );
if (-1=1en) {
br eak;

}

out.wite( b, 0, len);

of fset += len;

size -= len;

}

out.flush();

out.cl ose();

out = null;

Systemout.println( "End: " + new Date().toString() );

catch ( Exception ex )

{

ex. print StackTrace();
br eak;

}
}

In GroupWise 8.0 SP2 and later, the ability to stream attachments into GroupWise using HTTP PUT
was also added. The format of the URL is similar:

http(s)://server:port/attachnent ?sessi on=...& d=...&nane=...

+ http or https: HTTP protocol with or without SSL.

+ server: The IP address of the DNS name of the POA server.

+ attachment: The keyword to tell the POA to stream the attachment.

+ session: A valid login session is required.

+ id: The SOAP id of the item to receive the streamed attachment.

¢ port: The SOAP port.

+ name: The name of the attachment.
A personal attachment can be added to any item. If you want to send an item and stream the
attachments to the item, it is a multi-step process. You first create a draft item. You then stream the
attachments to the draft item. You then send an item using the sendltemRequest. You supply a link
element in the item in the sendltemRequest referencing the draft item. The values are first taken

from the item passed in the sendltemRequest. The information from the linked item is then added to
the item (including the attachments). After the item is sent, the draft item is purged.

The following Java code shows how to send a large attachment using the streaming code:
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public void testStreamAttachnent () {
byte[] bytes;
byte[] b = new byte[ 16384 ];
Cal endar end;
Cal endar start;
Distribution dist = new Distribution();
File file;
Fil el nput Stream in;
Ht t pURLConnecti on huc;

int code;

int len;

Li nkInfo l'ink = new Linklnfo();
Mail mail = new Mail ();

MessageBody nmb = new MessageBody();
MessagePart[] np = new MessagePart[1];
Qut put St ream o0s;

Reci pient[] recip = new Recipient[1];

Reci pientList list = new RecipientList();
Sendl t enResponse resp = null;

String id;

String str;

URL url;

try {
/] time the send

start = Cal endar. getlnstance();

/] setup a draft item
mai | . set Subj ect( "Test of HITP PUT" );
mai | . set Source( ItenBource.draft );

/'l get the nmessage body

bytes = "Message Body!". get Bytes( "UTF-8" );
np[ 0] = new MessagePart ();

np[ 0] . set _val ue( bytes );

nb. setPart( np );

nmai | . set Message( nb );

/1 set the recipient

recip[ O] = new Recipient();

recip[ O ].setDi splayNane( "Preston Stephenson” );

recip[ O ].setEmail( "pstephenson@restons. provo. novell.con' );
recip[ O ].setDi stType( D stributionType. TO);
|ist.setRecipient( recip );

di st.setRecipients( list );

nmai | . setDistribution( dist );

/] create the draft item
resp = mmain. get Service().sendltenRequest( mail,
m_mai n. get Sessi onl d(),
m_mai n. get Trace() );
if ( 0!=resp.getStatus().getCode() ) {
m mai n. di spl ayError( resp.getStatus(), "testStreamAttachnment” );

}
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/1 get the draft itemid, encode it for the URL
id = URLEncoder. encode(resp.getld()[0], "UTF-8");

/] set up the URL
str = "http://" + mmain.getLogin().getServer() + ":" +
m mai n. get Logi n().getPort() + "/attachnent ?sessi on=" +
m nai n. get Sessionld() + "& d=" + id + "&ane=onenb. txt";
url = new URL( str );

// set up the file to stream

file = new File( "c:\\tenp", "onenb.txt" );

str = String.valueOf( file.length() );

huc = (Htt pURLConnection)url.openConnection();

huc. set DoQut put ( true );

huc. set Request Met hod( " PUT" );

huc. set Fi xedLengt hStream nghbde( (int)file.length() );
0S huc. get Qut put St rean() ;

in new FilelnputStrean( file );

/] streamthe attachnent

for (;; ) {
len = in.read(b);
if (-1 ==1en) {
br eak;
}

os.wite( b, 0, len);

0s. cl ose();
code = huc. get ResponseCode();
if ( code < 200 || code > 299 ) {
m mai n. di spl ayError( resp.getStatus(), "testStreamAttachnent” );

}
/1 set up the mail itemto send
mail = new Mail ();

recip[ O] = new Recipient();

recip[ O ].setDi splayNanme( "Preston Stephenson” );

recip[ O ].setEmail ( "pstephenson@restons. provo. novell.con' );
recip[ O ].setDi stType( D stributionType. TO);
|ist.setRecipient( recip );

di st.setRecipients( list );

mai | . setDistribution( dist );

/] set the link to the draft item
l'i nk. set Type( LinkType.draft );
link.setld( resp.getld()[0] );

mai | . setLink( link );
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/1 send the item
resp = mnain. get Service().sendltenRequest ( mail,
m _mai n. get Sessi onl d(),
m mai n. get Trace() );

/1 get the el apsed tine
end = Cal endar. getlnstance();
str = "Streaming: " + String.valueO( end.getTinelnMIlis() -
start.getTinmelnMI1lis() );
m mai n. di spl ayError( resp.getStatus(), str );
} catch ( Exception e ) {
e.printStackTrace();

NOTE: There is not much of a performance increase for streaming small attachments. You should
consider streaming attachments over 64 KB in size.

Trusted Application

Trusted applications allow third-party applications access to all accounts on a GroupWise system,
without needing to know user passwords. In order for an application to use trusted application
authentication, GroupWise administrators must create a trusted application name and key. The
GroupWise administrator has control over the trusted application and decides which applications
can log in to the GroupWise system using the trusted application name and key.

Call the loginRequest method to log in as a trusted application.

For more information on trusted applications, see the NDK Trusted Application page (https://
www.novell.com/developer/ndk/groupwise_trusted_application_api.html).

Filters and Views

Filters help refine the search for items on a user's account. Views reduce the number of elements
returned on each item.

The following sections contain more information:

+ “Filters” on page 46
+ “Filtering on Different Item Types” on page 48

+ “Views” on page 57
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Filters

Filters refine a search for items. createCursorRequest and getltemsRequest use filters. Filters are
defined in the t ypes. xsd schema. You should keep your filters as simple as possible.

To create a simple filter, instantiate a Filter element and a FilterEntry element. Then, in the
FilterEntry element, add a field, value, and operation. For example, a field could have a subject value
that is set to “Novell.” The operation could have a contains value. The filter then returns a list of
items if the subject contains “Novell.”

Filter gwFilter = new Filter();// Instantiate a Filter
FilterEntry gwFE = new FilterEntry();// Instantiate a FilterEntry

gWFE. set Fi el d("subject");

gWFE. set Val ue(" Novel | ") ;

gWFE. set Op(Fi | t er Op. cont ai ns) ;

gWFi | ter.setEl enent (gWFE) ;// getltensRequest is called with the filter

The getltemsRequest and Response follows:

<get | t ensRequest >
<cont ai ner >7. donai nl. pol. 100. 0. 1. 0. 1@6</ cont ai ner >
<vi ew>subj ect </ vi ew>
<filter>
<el ement type="FilterEntry">
<op>cont ai ns</ op>
<fiel d>subject</field>
<val ue>Novel | </ val ue>
</ el emrent >
</filter>
<count >- 1</ count >
</ get | t ensRequest >

<get | t ensResponse>
<itens>
<itene
<i d>4513CC01. domai nl. pol. 100. 16E3837. 1. 1057. 1@l: 7.
domai nl. pol. 100.0. 1. 0. 1@6</id>
<cont ai ner >7. domai nl. pol. 100. 0. 1. 0. 1@L6</ cont ai ner >
<sour ce>r ecei ved</ sour ce>
<subj ect >Novel | announces Li nux</subj ect >
<litenp
<itene
<i d>4513CD2E. domai nl. pol. 100. 16E3837. 1. 1059. 1@l: 7.
domai nl. pol.100.0.1.0.1@6</id>
<cont ai ner >7. domai nl. pol. 100. 0. 1. 0. 1@.6</ cont ai ner >
<sour ce>r ecei ved</ sour ce>
<subj ect >Novel | exceeds Sal es</subject>
<litenmp
<litens>
<st at us>
<code>0</ code>
</ status>
</ get | t ensResponse>
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To create a more complicated filter, instantiate a Filter element and two FilterEntry elements. Next,
in both FilterEntry elements, add a field, value, and operation. Group the two FilterEntry elements

with a FilterGroup element. The FilterGroup element defines a FilterOp with a limited set of values:
and, or, and not.

The first FilterEntry returns items that have a subject that contains the string “Novell.” The second
FilterEntry returns items that have a date greater than a specific date. The two FilterEntry elements
are grouped together with an and operation.

Filter gwFilter = new Filter();// Instantiate a Filter
FilterGoup gwG = new FilterGoup();// Instantiate a FilterGoup
FilterEntry[] gWE = new FilterEntry[2];// Instantiate two FilterEntries

gWFE[ 0] = new FilterEntry();// Fill in FilterEntry one
gWFE[ 0] . set Fi el d("subj ect");

gWFE[ 0] . set Val ue(" Novel | ");

gWFE[ 0] . set Op(Filter Op. cont ai ns) ;

gWFE[ 1] = new FilterEntry();// Fill in FilterEntry two
gWFE[ 1] . set Fi el d("created");
gWFE[ 1] . set Val ue("2012-09-22T17: 45: 00Z2") ;

gWFE[ 1] . set Op(Fil terOp. gt);

gWFG set Op(FilterOp.and);// Goup the two FilterEntries with an "and"
gWFG set El ement (gWFE) ; // Add the two FilterEntries to the FilterGoup
gwFi lter.setEl enent(gwQ ;// Add the FilterGoup to the Filter

The getltemRequest and Response are shown below:

<get | t ensRequest >
<cont ai ner >7. donmi nl. pol. 100. 0. 1. 0. 1@.6</ cont ai ner >
<vi ew>subj ect </ vi ew>
<filter>
<el enent type="Filter G oup">
<op>and</ op>
<el ement type="FilterEntry">
<op>cont ai ns</ op>
<field>subject</field>
<val ue>Novel | </ val ue>
</ el ement >
<el ement type="FilterEntry">
<op>gt </ op>
<fiel d>created</field>
<val ue>2012- 09- 22T17: 45: 00Z</ val ue>
</ el ement >
</ el ement >
</filter>
<count >- 1</ count >
</ get |t ensRequest >
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<get | t ensResponse>
<itens>
<itemp
<i d>4513CD2E. donmi nl. pol. 100. 16E3837. 1. 1059. 1@L: 7.
domai nl. pol.100.0.1.0.1@6</id>
<cont ai ner >7. domai nl. pol. 100. 0. 1. 0. 1@6</ cont ai ner >
<sour ce>r ecei ved</ sour ce>
<subj ect >Novel | exceeds Sal es</subject>
<[itenp
</itens>
<stat us>
<code>0</ code>
</status>
</ getltensResponse>

Filtering on Different Item Types

Filtering is based on the different item types: mail, the GroupWise Address Book, and personal
address books.

You can search on dates relative to a floating date. The date options that are available are Today,
Tomorrow, ThisMonth, ThisWeek, ThisYear, and Yesterday. These values are defined in the FilterDate
element.

+ “Mail, Calendar, and Documents” on page 48

+ “GroupWise Address Book” on page 53

+ “Personal Address Book” on page 54

+ “Attachments” on page 56

Mail, Calendar, and Documents

Filters for mail, calendar, and documents use the following schema element names for the
FilterEntry field. Some fields accept only certain FilterOp operations.

+ created

+ delivered

+ modified

¢ startDate

+ startDay

+ endDate

+ endDay

¢ dueDate

+ @type-use FilterOp.eq on a single type, or use FilterOp.IsOf on multiple item types

+ to, bc, cc—string fields that are not a part of the recipient list

+ subject

+ source-use only FilterOp.isOf or FilterOp.isNotOf or FilterOp.eq
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status—use only FilterOp.isOf or FilterOp.isNotOf or FilterOp.eq
msgld

displayName

from/displayName

creator/displayName

author/displayName

versionCreator/displayName

email

from/email

creator/email

author/email

versionCreator/email

uuid

from/uuid

creator/uuid

author/uuid

versionCreator—use FilterOp.eq only

iCalld

text—a QuickFinder search that searches all text fields, message body, and attachments
acceptLevel-use only FilterOp.eq

place

subType—used with custom messages

caller, company, phone (Phone messages)
versionDescription

size (attachment size)

custom field or user-defined field

allDayEvent (--for GroupWise 2012 and later)
originalld (--for GroupWise 2012 and later)
documentNumber (--for GroupWise 2012 and later)
versionNumber (--for GroupWise 2012 and later)
category (--for GroupWise 2012 and later)
originalSubject (--for GroupWise 2012 and later)
taskCategory (--for GroupWise 2012 and later)
taskPriority (--for GroupWise 2012 and later)

xField (--for GroupWise 2012 and later)
retentionModified (--for GroupWise 2012 and later)
folder (--for GroupWise 2012 and later)
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+ sid (--for GroupWise 2012 and later)
+ assignedDate (--for GroupWise 2012 and later)

This section contains the following examples:

+ “Mailbox Example” on page 50
+ “Sent Items Example” on page 50
+ “Searching Elements Example” on page 51

+ “Relative Example” on page 52

Mailbox Example

Suppose you want to return only appointments in the Mailbox by calling getltemsRequest. Use the
@type attribute in the field value. The @ signals an attribute in the schema.

The following example request and response use the @type = Appointments on the Mailbox
container:

<get | t ensRequest >
<cont ai ner >7. donai nl. pol. 100. 0. 1. 0. 1@6</ cont ai ner >
<vi ew>subj ect </ vi ew>
<filter>
<el ement type="FilterEntry">
<op>eq</ op>
<field>@ype</field>
<val ue>Appoi nt nent </ val ue>
</ el enent >
</filter>
<count >- 1</ count >
</ get | t ensRequest >

<get | t ensResponse>
<itens>
<itemt ype="Appoi nt nent " >
<i d>44FEDC3B. dormai nl. pol. 100. 1676834. 1. 76F. 1@: 7.
donmai nl. pol. 100.0. 1. 0.1@6</id>
<cont ai ner >7. domai nl. pol. 100. 0. 1. 0. 1@L6</ cont ai ner >
<sour ce>r ecei ved</ sour ce>
<subj ect >Del egat ed Appt </ subj ect >
<litemp
</itens>
<stat us>
<code>0</ code>
</ status>
</ get | t ensResponse>

Sent Items Example

The following example returns all items from a container that are sent items by calling
getltemsRequest. The value in the filter could be replaced with received, sent, draft, or personal.
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<get | t ensRequest >
<cont ai ner >7. donai nl. pol. 100. 0. 1. 0. 1@.6</ cont ai ner >
<vi ew>subj ect </ vi ew>
<filter>
<el ement type="FilterEntry">
<op>eq</ op>
<fiel d>source</field>
<val ue>sent </ val ue>
</ el enent >
</[filter>
<count >- 1</ count >
</ getltensRequest >

<get | t ensResponse>
<itens>
<itene
<i d>44EQAGE4. donmi nl. pol. 100. 16E3837. 1. EFD. 1@: 7
domai nl. pol.100.0. 1. 0.1@6</id>
<cont ai ner >7. domai nl. pol. 100. 0. 1. 0. 1@L6</ cont ai ner >
<sour ce>sent </ sour ce>
<subj ect >novi ng an itenx/subject>
<litenp
<litens>
<st at us>
<code>0</ code>
</ st atus>
</ get | t ensResponse>

Searching Elements Example

The following example searches all text element fields, including the message body and attachments

for a specific string by calling getltemsRequest:

<get | t ensRequest >
<cont ai ner >7. donai nl. pol. 100. 0. 1. 0. 1@6</ cont ai ner >
<vi ew>subj ect message</vi ew>
<filter>
<el ement type="FilterEntry">
<op>eq</ op>
<field>text</field>
<val ue>Test of the energency broadcast system </val ue>
</ el enent >
</filter>
<count >- 1</ count >
</ get | t ensRequest >
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<get | t ensResponse>
<itens>
<itemp
<i d>4513F160. donmi nl. pol. 100. 16E3837. 1. 105B. 1@.: 7.
donmmi nl. pol.100.0.1.0.1@6</id>
<cont ai ner >7. domai nl. pol. 100. 0. 1. 0. 1@6</ cont ai ner >
<sour ce>r ecei ved</ sour ce>
<subj ect >Test mmi| nessage</subject>
<nessage>
<part content Type="text/plain"
I engt h="112">VGhpcyBpcyBhl HRI c3Qb2YgdChl | Gvt ZXInZWb
j €SBi cmBhZG\hc3Qyc3l zdGVvt Li AgVGhpcyBpcyBvbmx 51 GEgdGV
zdCAKCnFzZGZhe 2 ==
</ part>
</ message>
<litenp
</itens>
<st at us>
<code>0</ code>
</status>
</ getltensResponse>

Relative Example

The following example demonstrates retrieving all items with a startDate greater than or equal to
two days before today by calling getltemsRequest.

In the date element below, the relative date is Today. The field is the startDate with a value of -2.
Using -2 as tje value subtracts two days from Today.

<get | t ensRequest >
<cont ai ner >7. donai nl. pol. 100. 0. 1. 0. 1@6</ cont ai ner >
<vi ew>subj ect </ vi ew>
<filter>
<el ement type="FilterEntry">
<op>fi el dGTE</ op>
<field>startDate</field>
<val ue>- 2</ val ue>
<dat e>Today</ dat e>
</ el enent >
</[filter>
<count >- 1</ count >
</ get | t ensRequest >
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<get | t ensResponse>
<itens>
<itemtype="Mil">
<i d>452A40F1. dommi nl. pol. 100. 16E3837. 1. 109B. 1@.: 7.
domai nl. pol.100.0. 1. 0.1@6</id>
<cont ai ner >7. domai nl. pol. 100. 0. 1. 0. 1@6</ cont ai ner >
<sour ce>per sonal </ sour ce>
<subj ect >Rel ati ve Date Exanpl e</ subj ect >
<[itenp
</itens>
<stat us>
<code>0</ code>
</status>
</ getltensResponse>

GroupWise Address Book

Creating a filter for GroupWise Address Book items can use the following schema element names for
the FilterEntry field. Some fields take only certain FilterOp operations. The email address is not a
part of the fields that are available to search. The email address is not indexed. It is built from the
parts, such as displayName@iDomain.

+ created

+ @type-use FilterOp.eq only

+ department

+ fullName/firstName

+ fullName/lastName

+ username—login ID to GroupWise

+ uuid-use FilterOp.eq only

¢ domain

+ postOffice
Filtering the GroupWise Address Book using firstName, lastName, displayName, or department is

fastest because the fields are indexed. If you filter using any of the other fields, the searches are
time-consuming because the fields are not in the index.

The following example demonstrates calling getltemsRequest:
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<get | t ensRequest >
<cont ai ner >G oupW seSyst emAddr essBook @2</ cont ai ner >
<vi ew>nul | </ vi ew>
<filter>
<el ement type="FilterEntry">
<op>eq</ op>
<fiel d>l ast Name</fiel d>
<val ue>LAST01010000</ val ue>
</ el enent >
</filter>
<count >- 1</ count >
</ getltensRequest >

<get | t ensResponse>
<itenms>
<itemtype="Contact">
<i d>07B4A660- 18CA- 0000- B989-
BAOOEBOOODOO@6: Gr oupW seSyst emAddr essBook @2</ i d>
<nane>F| RST01010000 LAST01010000</ name>
<ver si on>1</versi on>
<nmodi fi ed>2005- 10- 31T20: 06: 55Z</ nodi fi ed>
<cont ai ner >G oupW seSyst emAddr essBook @2</ cont ai ner >
<creat ed>2005- 10- 31T20: 06: 39Z</ cr eat ed>
<uui d>07B4A660- 18CA- 0000- B989- BAOOEBOOODOO</ uui d>
<domai n>domai nl</ domai n>
<post O fi ce>po2</post O fi ce>
<di sti ngui shedNane>USER01010000. SERVER</ di sti ngui shedNanme>
<useri d>USER01010000</ useri d>
<ful | Nane>
<di spl ayNane>FI RST01010000 LAST01010000</ di spl ayNane>
<firstNane>Fl RST01010000</ fi r st Name>
<| ast Nane>LAST01010000</ | ast Nane>
</ ful | Name>
<emai | Li st primary="USER01010000@hant om conf >
<enui | >USER01010000@hant om conx/ enmai | >
</ email Li st>
<litenp
</itens>
<st at us>
<code>0</ code>
</ status>
</ getltensResponse>

Personal Address Book

Creating a filter for personal address book items can use the following schema element names for
the FilterEntry field. Some fields only take certain FilterOp operations.

+ @type-use FilterOp.eq only

*

department

*

displayName or name

*

fullName/firstName

*

fullName/lastName
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+ fullName/middleName

+ fullName/namePrefix

+ fullName/nameSuffix

+ postOffice

+ username—login id to GroupWise
+ uuid-use FilterOp.eq only

+ emailLlist/email

+ emaillist/@primary

+ created

+ modified

+ organization (for GroupWise 2012 and later)

The following example returns group items in a personal address book by calling getltemsRequest:

<get | t ensRequest >
<cont ai ner >42C510EA. domai nl. pol. 104. 16E3837. 1. 3. 1@®3</ cont ai ner >
<vi ew>nul | </ vi ew>
<filter>
<el ement type="FilterEntry">
<op>eq</ op>
<fiel d>@ype</field>
<val ue>G oup</ val ue>
</ el enent >
</[filter>
<count >- 1</ count >
</ get | t ensRequest >

<get | t ensResponse>
<itens>

<itemtype="G oup">

<i d>44FD7ACL. dormi nl. pol. 104. 16E3837. 1. FF. 1@8: 42C510EA.
domai nl. pol. 104. 16E3837. 1. 3. 1@®3</i d>
<nanme>Q&2</ nane>
<ver si on>1</ ver si on>
<nmodi fi ed>2012- 09- 05T19: 25: 21Z</ nodi fi ed>
<cont ai ner >42C510EA. domai nl. pol. 104.
16E3837. 1. 3. 1@®3</ cont ai ner >

<creat ed>2012- 09- 05T19: 25: 21Z</ cr eat ed>
<comment >asdf </ conment >

<litemp

<itemtype="Goup">
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<i d>44EB3142. dommi nl. pol. 104. 16E3837. 1. FO. 1@8: 42C510EA.
dormmi nl. pol. 104. 16E3837. 1. 3. 1@®3</i d>
<nane>Q oup</ name>
<ver si on>5</ ver si on>
<nodi fi ed>2012- 09- 05T15: 12: 09Z</ nodi fi ed>
<cont ai ner >42C510EA. dorai nl. pol. 104. 16E3837.
1. 3. 1@®3</ cont ai ner>
<creat ed>2012- 08-22T22: 30: 58Z</ cr eat ed>
<litemp
<litens>
<stat us>
<code>0</ code>
</ status>
</ getltensResponse>

Attachments

It might be useful to search for items that have a certain type of attachment.

+ SharedAttachmentTypes - (shared attachments)

+ PersonalAttachmentTypes - (personal attachments)
The filter operations that can be used with these fields are:

+ exists
+ isOf
+ isNotOf

The values that can be in the value element are:

+ MessageBody
+ File

+ Recipients
The value string is a space delimited combination of the above values.

You have to test for the existence of the field as well as the values. For example, to return items that
have a personal message body or HTML message body (text.htm), the filter would be:

<filter>
<el ement xsi:type="FilterGoup">
<op>and</ op>
<el ement xsi:type="FilterEntry">
<op>exi st s</ op>
<fi el d>Personal Att achment Types</fi el d>
</ el enent >
<el ement xsi:type="FilterEntry">
<op>i sOf </ op>
<fi el d>Personal Att achment Types</fi el d>
<val ue>MessageBody Fil e</val ue>
</ el enent >
</ el enent >
</filter>
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Using the isNotOf operation is tricky. Contact development if you want to use this operation. Here is
an example of getting items that have shared attachments only (no personal):

<filter>
<elenment xsi:type="FilterEntry">
<op>nhot Exi st </ op>
<fi el d>Personal Att achnment Types</fi el d>
</ el enent >
</filter>

Views

This section contains the following topics:

+ “View Elements” on page 61

+ “View Examples” on page 63
Views reduce the elements returned on each item. Your applications can leverage views to retrieve
only the item elements you are interested in. For example, suppose an application is retrieving items
in the mailbox folder. You need to display only the subject and modified date. The application can

specify a subject modified view. Each item in turn returns the subject and modified date. There are a
few additional fields that are returned, such as the container, the item ID, and the source.

The view element is a space-delimited list of leaf elements defined in t ypes. xsd schema. For
example, t ypes. xsd defines the subject element as <subj ect" type="string"/>.The
element name is subject, which can be added to the view.

The following methods have a view parameter:

+ createCursorRequest (page 88)
+ forwardRequest (page 104)
+ getDeltasRequest (page 128)
+ getFolderRequest (page 136)
+ getFolderListRequest (page 138)
+ getltemRequest (page 146)
+ getltemsRequest (page 148)
+ getQuickMessagesRequest (page 169)
+ replyRequest (page 240)
It is a good idea to look at the responses for the respective requests to determine the type of

elements that can be added to the view. It does not make sense to add subject to the view when
calling getFolderListRequest because getFolderListRequest does not return a subject.

Some important view strings are as follows:

all

The administrator can limit what fields are returned when getting the GroupWise Address Book
entries. If you supply this value and you have logged in as a trusted application, you can get back
all of the fields.

This is also used to get all the status from the access right list in a shared folder.
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assignedDate

When a task is originally created, the startDate is also put in the assginedDate field. After the
dueDate is reached and the task has not yet been completed, the startDate is changed to the
current date.

For GroupWise 2012 and later.

attachment or attachments

The attachment reference is returned with the item. getAttachmentRequest is used to retrieve
the actual file attachments.

The HTML message body is included as an attachment. It is the first attachment and is named
text.htm

Retrieve the attachment information only when necessary. This view requires the POA to do
more work, which affects performance.

checklist

Returns the checklist/tasklist elements: sequence number, due date, percent completed,
completed date, and checklist thread.

clientMessageld

Returns the clientMessageld. This is the same id that you will see when you open an item in the
GroupWise Windows client. Select Properties and find the Message Id.

contactNotes

Starting in GroupWise 8.0 SP3, contact notes are not returned by default when getting contacts
from a personal address book. You must now pass this value to get the contact notes.

For GroupWise 2012 and later.

count
If the item type is a folder, a count of items that are in the folder is returned.

If the item type is a Contact (UserContact) folder or personal address book, the count of items in
the container is returned.

For GroupWise 2012 and later.

custom

To get a specific custom value returned, you must specify the custom field name prefixed with
“custom/”. For example, if you want to get the custom field “MyAppRead”, you would put
“custom/MyAppRead” in the view. You must list each custom field name separately. Here is an
example of getting two different custom fields:

<vi ew>default custonl MyAppRead custom al exStrFi el d</vi ew>

default

An important subset of elements is returned, based on the item type. Additional keywords can
be included with the default keyword, which reduces the need to include all elements in the
view.

The default keyword returns a different set of elements, based on the item type.
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flush
The user’s folder list is cached while the user is logged in. Use the flush keyword to make sure a
fresh copy of the folders and their attributes are read when accessing a folder.

format

The subject text can include certain formatting codes (underline, bold and italics). To get these
formatting codes returned, specify "format" in the view. The allowed formatting codes in the
text are:

<b> bol d on

</b> bold off

<i> italics on
</[i> italics off
<u> underline on
</u> wunderline off

These values are only on the subject field or the originalSubject field if the subject is
personalized. Here is an example of a personalized subject::

<subj ect >This is ny subject! </subject>
<origi nal Subject>&t; b&gt; This& t;/b&gt; & t;u&gt;is&t;/u&gt;
the & t;i&gt;subject&t;/i&gt;!</original Subject>

Note: the '<' and '>' are escaped in the XML. The strings would be:

"This is ny subject!"”
"<b>Thi s</ b> <u>i s</u> the <i>subject</i>!"

hidden

Hidden items are returned.

members

Returns the members of a personal address group.

message or message/RTF

The message body is returned. If message is included, the plain text message body is returned.
If message/RTF is included, the rich text format of the message body is returned.

NOTE: The plain text message body can be stored in two different formats, plain text or RTF. If
you want to get the message body as plain text (no RTF codes), you request “message” in the
view. If you want to get back the message body, with the RTF codes, you request “message/
RTF”. If the message body is stored as plain text (no RTF codes), the message body will always be
returned as plain text. We do not add RTF codes to the plain text.

Retrieve the message body only when necessary. This view requires the POA to do more work,
which affects performance.

messagelD

A shortened version of the item ID is returned. This shortened version matches the IMAP item
ID. The SOAP version of the item ID is msgID.
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noContactNotes

In GroupWise 8.0 SP2, it was determined that getting the contact notes on contacts could

significantly affect the performance of the POA. This keyword was added to not get the contact
notes.

For GroupWise 8.0 SP2 and later.
noDisplay
In GroupWise 8.0, the display settings for folders where returned by default. Setting noDisplay
prevents those settings from being returned.
For GroupWise 8.0 SP2 and later.

noDownload

Usually, when the peek flag is passed in the view and the message body is requested, the item is
not marked as opened. A third-party downloaded flag is set to indicate that the user may have
seen the message body. In some cases, this is undesirable. It gives a user an indication that
someone or some application has viewed the message body. Pass this keyword to prevent the
third-party downloaded flag from being set. This flag is dependent on the application having
logged into the user’s account with a trusted application name and key.

For GroupWise 8.0 SP3 and later.

normal

By default, if you log in with a trusted application, you get all entries from the GroupWise
Address Book (even the hidden ones). If you want to be able to only get the entries the user has
rights to see, you must pass “normal” in the view.

peek

If an application reads an item and its message body, the item is marked as opened and read.
With the peek keyword, however, the item is marked as opened but not read. The item is
marked as downloaded by a third party.

recipient or recipients

The recipients list is returned. Typically, the recipient or recipients keyword is required only if
you are responding to a distribution list. If you need to display the recipients, there is a string
representation of the To, CC, and BC fields that are returned with the default keyword.

Retrieve the recipient's information only when necessary. This view requires the POA to do
more work, which affects performance.

recipientStatus

When a user sends an item to other users, recipientStatus information is tracked. On sent items,
the recipientStatus information is returned. Also, recipientStatus is available to the received
item if you are the sender of the item. The recipientStatus implies recipients and recipient
information is returned also.

Retrieve the recipientStatus information only when necessary. This view requires the POA to do
more work, which affects performance.

rssURL
Returns the RSS URL.
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sid
If you put sid in the view, the <sid> values are returned as the values in the <item> elements.
For GroupWise 8.0 HP1 and later.

sids

If you put sid and sids in the view, the <sid> values are returned in a space delimited <sids>
element instead of the <items> element.

For GroupWise 2012 and later.
stubbed

Returns stubbed items. See the stubbing/archive documentation for more information.

threading

Returns the discussion threading for an item.

unReadCount

If the item type is a folder, the count of unread items that are in the folder is returned.

xfield
Returns the MIME RFC 822 X-Field values.
For GroupWise 2012 and later.

View Elements

The following list of elements can be added to the view:

*+ message

+ message/RTF
+ acceptlLevel
+ allDayEvent
+ itemType
¢ startDate
+ delivered
+ source

* company
+ caller

¢ phone

+ created

+ endDate

+ to

* cC

* bc

+ from

+ email
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¢+ name

+ timezone

+ attachment

+ attachments
+ peek

+ default

+ hidden

+ modified

+ id

+ msgld

* messagelD

+ place

+ subject

* priority

+ recipientStatus
+ uuid

+ version

* security

+ statusTracking
+ requestReply
+ sendoptions
+ iCalld

* recurrenceKey
+ recipients

+ recipient

+ recipientStatus
+ hasAttachments
¢ count

+ unReadCount
+ parent

+ description

+ sequence

+ all

¢ container

* priority

* expires

+ created

+ size
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*

*

smimeType

subType

mimeEncoding

nntpOrimap

alarm

all (for GroupWise Address Book fields)
category

checklist

clientMessageld

flush

members

normal (for GroupWise Address Book entries)
originalSubject

rssURL

stored (Return the stored name folder name for a system folder instead of the language
dependent name.)

stubbed
threading

The following list of elements were added in GroupWise 8.0 SP2:

*

*

noDisplay

noContactNotes

The following list of elements were added in GroupWise 8.0 SP3:

*

*

*

contactNotes
noDownload

retentionModified

The following list of elements were added in GroupWise 2012:

*

*

assignedDate

pabName (Return the address book name as the name of the corresponding user contact
folder.)

xField

View Examples

This section contains the following examples:

*

*

“Default View Example” on page 64

“Expanded View Example” on page 65
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Default View Example

The following example gets an item from the Mailbox with the default view by calling
getltemsRequest:

<get | t ensRequest >
<cont ai ner >7. donai nl. pol. 100. 0. 1. 0. 1@6</ cont ai ner >
<vi ew>def aul t </ vi ew>

</ get | t ensRequest >

<get | t ensResponse>
<itens>
<itemp
<i d>43BA73CB. domai nl. pol. 100. 1676834. 1. 6FB. 1@.: 7
domai nl. pol.100.0.1.0.1@6</id>
<ver si on>3</ versi on>
<nodi fi ed>2012- 01- 03T19: 59: 40Z</ nodi fi ed>
<cont ai ner >7. domai nl. pol. 100. 0. 1. 0. 1@6</ cont ai ner >
<creat ed>2012- 01-03T19: 53: 31Z</ cr eat ed>
<st at us>
<opened>1</ opened>
<read>1</read>
</ status>
<nmsgl d>43BA73CB. donmai nl. pol. 200. 20000CB. 1. 111D. 1</ nsgl d>
<sour ce>r ecei ved</ sour ce>
<del i vered>2012- 01- 03T19: 53: 31Z</ del i ver ed>
<security>Normal </ security>
<subj ect >Fwd: Test Message from Ul</subject>
<di stribution>
<fronmp
<di spl ayNane>ul</ di spl ayNanme>
<enai | >ul. pol. domai nl</ enmuil >
<uui d>1DEB6970- 175B- 0000- 890F- 6E00D5004E00</ uui d>
</fronp
<t o>u2</t o>
<sendopt i ons>
<st at usTr acki ng>None</ st at usTr acki ng>
</ sendopt i ons>
</distribution>
<options>
<priority>Standard</priority>
</ options>
<hasAt t achment >1</ hasAt t achnent >
<si ze>1189</ si ze>
<litenp
</itens>
<st at us>
<code>0</ code>
</ status>
</ get | t ensResponse>
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Expanded View Example

The following example is the same as the preceding one, except that it includes the attachments,
recipients, message, and peek keywords by calling getltemRequest. It also contains the attachments,
recipients, and message elements.

<get | t enRequest >
<i d>4512B362. donmi nl. pol. 100. 1676834. 1. 798. 1@.: 7.
donai nl. pol.100.0. 1. 0.1@6</id>
<vi ew>default nessage attachnments recipients peek</vi ew>
</ get | t enRequest >

<get | t enResponse>

<itenp
<i d>4512B362. donui nl. pol. 100. 1676834. 1. 798. 1@.: 7.
domai nl. pol.100.0.1.0.1@6</id>
<ver si on>2</ versi on>
<nodi fi ed>2012- 09-21T21: 44: 48Z</ nodi fi ed>
<cont ai ner >7. donmai nl. pol. 100. 0. 1. 0. 1@6</ cont ai ner >
<creat ed>2012-09-21T21: 44: 34Z</ cr eat ed>
<st at us/ >
<nsgl d>4512B362. domai nl. pol. 200. 20000CA. 1. 673. 1</ nsgl d>
<messagel d><4512B362. 261E. 00CA. 0@hant om conp</ nessagel d>
<sour ce>r ecei ved</ sour ce>
<del i ver ed>2012- 09- 21T21: 44: 34Z</ del i ver ed>
<security>Normal </ security>
<subj ect >Test message</ subj ect >
<di stri bution>
<fronp
<di spl ayName>u2</ di spl ayNane>
<emai | >u2@hant om conx/ emai | >
<uui d>42F9A600- 175B- 0000- 890F- 6E00D5004E00</ uui d>
</fronp
<t o>u2</t o>
<r eci pi ent s>
<r eci pi ent >
<di spl ayName>u2</ di spl ayNane>
<emai | >u2@hant om conx/ emai | >
<uui d>42F9A600- 175B- 0000- 890F- 6E00D5004E00</ uui d>
<di st Type>TO</ di st Type>
<reci pType>User</reci pType>
</ recipient>
</ recipients>
<sendopt i ons>
<st at usTr acki ng>None</ st at usTr acki ng>
</ sendopt i ons>
</ distribution>
<nessage>
<part content Type="text/plain"
| engt h="40">VGhpcyBpcyBhl GLI c3NnZ2UgYnBkeS4KCnFz ZGYK</ par t >
</ message>
<attachnment s>
<attachnent >
<i d>4512B362. donai nl1. pol. 200. 20000CA. 1. 671. 1@5:
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4512B362. dommi nl. pol. 100. 1676834. 1. 798. 1@l.: 7.
domai nl. pol.100.0. 1. 0.1@6</id>
<name>Web Servi ces Abstracts. odt </ name>
<cont ent Type>appl i cati on/ vnd. oasi s.
opendocunent . t ext </ cont ent Type>
<si ze>15500</ si ze>
<dat e>2012- 09- 15T12: 39: 06Z</ dat e>
<hi dden>0</ hi dden>
</ attachnent >
</ attachnment s>
<opti ons>
<priority>Standard</priority>
</ opti ons>
<hasAt t achnent >1</ hasAt t achnent >
<si ze>16346</ si ze>
<litenp
<st at us>
<code>0</ code>
</ status>
</ getltenResponse>

ContactNotes on a Contact

ContactNotes provide the ability to add a list of notes to a contact. These notes operate as
attachments on a contact. Each attachment has a unique id and creation date. Comments are also
available and have been augmented with ContactNotes.

Getting contact notes can place a heavy load on the POA. In 8.0 SP2, the keyword
(“noContactNotes”) was added to not get the contact notes when getting the personal address book
items.

In GroupWise 8.0 SP3, it was decided to make the default be that contact notes are not returned.
You must explicitly ask for the contact notes by putting “contactNotes” in the view.
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Creation of a ContactNote

Below is a trace creating a ContactNote on an existing contact. The method modifyltemRequest is

called with the id of the contact to modify.

<nsO0: nodi fyl t emRequest >
<nsO0: i d>48FEE952. domai nl. pol. 104. 16A6163. 1. 4A. 1@6: 4847C63F. domai nl. pol. 10
4.16A6163. 1. 3. 1@3</ ns0:i d>
<ns0: updat es>

<ansl:add xm ns:ansl="http://schenmas. novel |.com 2005/ 01/ G oupW se/ t ypes"

Xsi :type="ansl: Cont act ">

<ansl:
<ansl:
<ansl:
<ansl:
<ansl:
<ansl:
<ansl:

ver si on>0</ ansl: versi on>

cont act Not es>

cont act Not e>

attachnent >

cont ent Type>t ext/ pl ai n</ ansl: cont ent Type>

si ze>0</ ansl: si ze>

dat a>QARkaWbnl HZpYSBTTOFQ COgMQX==</ ans1: dat a>

</ ansl: attachnent >
</ ansl: cont act Not e>
</ ansl: cont act Not es>
</ ansl: add>

</ nsO:

updat es>

<nsO0: recurrenceAl | | nst ances>0</ ns0: recurrenceAl | | nst ances>

</ nsO:

nodi fyl t enRequest >

Below is Java code that demonstrates how to create a ContactNote:

private void addCont act Not e()

{

Modi fyl t emResponse mRes = new Modi fylt emResponse();
| t enChanges i Changes = new |t emChanges();

Cont act Not e[] gwCont act Note = new Cont act Note[ 1] ;
Cont act Not es gwCont act Not es = new Cont act Notes() ;

Contact gwContact = new Contact();

Attachmentltem nfo attachnent = new Attachnent|temn nfo();
String sNote = new String("Adding via SOAP - 1");

byte[] gwByte = new byte[sNote.length()+1];

try

{

gwByt e=new byt e[ sNot e. | engt h() +1] ;

gwByt e=sNot e. get Byt es(" UTF8") ;

}

catch (UnsupportedEncodi ngException ex)

}
}

ex. print StackTrace();

attachnent =new Attachnentltem nfo();
attachnent. set Cont ent Type("text/plain");
attachnent . set Dat a(gwByt e) ;

gwCont act Not e[ 0] =new Cont act Not e() ;
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gwCont act Not e[ 0] . set Att achnent (attachnent);
gwCont act Not e. set Cont act Not e( gwCont act Not e) ;
gwCont act . set Cont act Not es( gwCont act Not es) ;

i Changes. set Add( gwCont act);

Get | t emsResponse res=get Cont act Notes();

try

{

mRes = m gwMai n. get G oupW seServi ce(). nodi fyl t enRequest (
res.getlten().getltenm()[0].getld(), null, icChanges,DO0,
m gwMai n. get G oupW seServi celd(), false);

}

catch (Renot eException ex)

{

ex. printStackTrace();
}

Modification of a ContactNote

Below is a trace modifying an existing ContactNote on a contact. Notice the contact id is just below
the modifyitemrequest method call. The ContactNote id is in the updates > update > contactnotes >
contactnote section.

<nsO0: nodi fyl t emRequest >

<ns0i d>48FEE952. donmmi nl. pol. 104. 16A6163. 1. 4A. 1@6: 4847C63F. domai nl. pol. 104
.16A6163. 1. 3. 1@3</ ns0: i d>

<ns0: updat es>

<ansl:update xm ns:ansl="http://schenas. novell.conl 2005/ 01/ G oupW se/
types" xsi:type="ansl: Contact">

<ansl:versi on>0</ansl: versi on>

<ans1: cont act Not es>

<ans1: cont act Not e>

<ansl:i d>4906DFDF. domai nl. pol. 100. 16A6163. 1. 1413. 1@: A. donmai nl. pol. 100.0. 1
.0.1@9</ ansl:id>

<ansl: attachment >

<ansl:id

i tenRef erence="f al se" >4906DFDF. donai nl. pol. 100. 16A6163. 1. 1412. 1@5</
ansl:id>

<ansl: cont ent Type>t ext/ pl ai n</ ansl: cont ent Type>

<ansl:si ze>0</ansl: si ze>

<ansl: dat a>TWokaWZpY2F0aWoul HZpYSBTTOFQ COgMQ==</ ans1: dat a>

</ ansl: attachnment >

</ ansl: cont act Not e>

</ ansl: cont act Not es>

</ ansl: updat e>

</ ns0: updat es>

</ ns0: nodi fyl t enRequest >
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Deletion of a ContactNote

Below is a trace deleting an existing ContactNote on a contact. Notice the contact id is just below the
modifyitemrequest method call. The ContactNote id is in the updates > delete > contactnotes >
contactnote section.

<nsO0: modi fyl t emRequest >

<nsO0: i d>48FEE952. domai nl. pol. 104. 16A6163. 1. 4A. 1@6: 4847C63F. donai nl. pol. 10
4.16A6163. 1. 3. 1@3</ ns0:i d>

<ns0: updat es>

<ansl:del ete xm ns:ansl1="http://schenas. novel | .conl 2005/ 01/ G oupW se/
types" xsi:type="ansl: Contact">

<ansl:versi on>0</ansl: versi on>

<ans1: cont act Not es>

<ans1: cont act Not e>

<ansl:i d>4906DFDF. domai nl. pol. 100. 16A6163. 1. 1413. 1@: A donai nl. pol. 100.0. 1
.0.1@9</ansl:id>

</ ansl: cont act Not e>

</ ansl: cont act Not es>

</ ansl: del ete>

</ nsO: updat es>

<ns0: recurrenceAl | I nst ances>0</ ns0: recurrenceAl | | nst ances>

</ ns0: nodi fyl t enRequest >

Display Settings

You can get the Display Settings for the Windows client. There are several different types of display
settings that can be retrieved.

NOTE: In GroupWise 8.0 SP2, the noDisplay keyword was added to the view so the folder display
settings are not returned when getting the folder(s) object. The display settings are not needed in
normal use. There is thus no reason to get the settings for most cases. This reduces some of the
SOAP traffic.

Folder

Returns the folder display settings list. In the Windows client, you can view this same
information by selecting View > Display Settings > Select from the main toolbar.

To get the Folder display settings, you need to call getltemsRequest with “Folder” as the
container. For example, getltemsRequest (“Folder”,view, null, null, 0, session, false);.
FolderDefault

Returns the folder list default display settings. In other words, it shows all the default settings
for the system folders.

To get the FolderDefault display settings, you need to call getltemsRequest with
“FolderDefaults” as the container. For example, getltemsRequest (“FolderDefault”, view, null,
null, 0, session, false);.
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Panel
Returns the panels defined on the home folder for the user.
To get the Panel display settings, you need to call getltemsRequest with “Panel” as the
container. For example, getltemsRequest (“Panel”, view, null, null, 0, session, false);.
PanelTemplates

Returns all the available panels and their settings. In the Windows client, you can view this
same information by selecting View > Display Settings > Panels from the main toolbar.

To get the panelTemplates display settings, you need to call getltemsRequest with
“PanelTemplates” as the container. For example, getltemRequest(“PanelTemplates”, view, null,
null, 0, session, false);.

Item Modification

Received and sent items are for the most part read-only. There are a few fields that you can make
some personalization to the original item. You can change the following fields:

+ Subject

+ Categories

+ xField

+ Personal attachment

+ Contact

+ Alarm (Appointment items)

+ acceptlLevel (Appointment items)

¢ Checklistinfo

¢ Custom fields
Sent appointments and received appointment (where you are the sender) have other fields that can
be changed. If you modify the start time, end time or place of one of these appointments, the POA

does extra logic. It retracts the original appointment and send out a new appointment with the
updated times or place.

It is also possible to change the recipients. This applies if you are just adding or removing recipients
(not changing the time or place of the appointment). In this case, you supply a new Distribution
element in the <add> element of the temChanges for the modifyltemRequest. You add the
recipients you want in the final appointment. If there are recipients in the original appointment that
are not in the updated appointment, the appointment is retracted from those users. If there are new
recipients in the updated appointment, the appointment is sent to those users. If there are
recipients in the old appointment and new appointment, the appointment is not sent to them. You
also have to supply the updated to, cc and / or bc elements in the Distribution element.

The modifying of sent and received appointments was added in GroupWise 8.0 SP2.

In GroupWise 2012, you can also use the resendRequest. This is the same concept as in the
GroupWise client. You can make extensive changes and then send the new item using
sendltemRequest. You need to manually retract the original item using the retractRequest.
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Example

<i d>4D3E9ACB. donai n. POL. 100. 1776172. 1. 25C9C. 1@ : A. domai n. POL. 100. 0. 1. 0. 1@

9
</id>
<updat es>
<add type="Appoi ntnent" >
<di stri bution>
<t o>Prest on Stepehnson; Jay Parker</to>
<r eci pi ent s>
<reci pient type="Recipient">
<di spl ayNane>Pr est on St ephenson</di spl ayNane>
<enai | >pst ehenson@r est ons. novel | . conx/ enai | >
<uui d>2D16B180- 0922- 0000- 846C- 82BD300F9E1C</ uui d>
</reci pi ent >
<reci pient type="Recipient">
<di spl ayNane>Jay Parker </ di spl ayNanme>
<enui | >j par ker @r est ons. novel | . conx/ emai | >
<uui d>C974CA00- 0B55- 0000- B976- 8E9OE5B002BD</ uui d>
</reci pi ent >
</ reci pi ent s>
</ distribution>
</ add>
</ updat es>
</ nodi fyl t enRequest >

<nodi fyl t enResponse>
<nodi fi ed>2011-01-25T17: 51: 11Z</ nodi fi ed>
<st at us>
<code>0</ code>
</ status>
</ modi fyl t emResponse>
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Methods

You must call loginRequest before calling any other methods. The loginRequest method returns a
session key in the loginResponse that is required by all other methods during that session.

This section contains the following GroupWise Web Services methods, which are defined in the
nmet hods. xsd schema file:

+ “acceptRequest” on page 76

+ “acceptShareRequest” on page 78

+ “addltemRequest” on page 80

+ “addltemsRequest” on page 81

+ “addMembersRequest” on page 82

+ “archiveRequest” on page 83

+ “closeFreeBusySessionRequest” on page 86

+ “completeRequest” on page 87

+ “createCursorRequest” on page 88

+ “createltemRequest” on page 90

+ “createltemsRequest” on page 92

+ “createJunkEntryRequest” on page 93

+ “createNotifyRequest” on page 94

+ “createProxyAccessRequest” on page 96

+ “createSignatureRequest” on page 98

+ “declineRequest” on page 99

+ “delegateRequest” on page 100

+ “destroyCursorRequest” on page 102

+ “executeRuleRequest” on page 103

+ “forwardRequest” on page 104

+ “getAccountlistRequest” on page 106

+ “getAddressBookListRequest” on page 107

+ “getArchiveltemsRequest” on page 109

+ “getAttachmentRequest” on page 111

+ “getCategorylListRequest” on page 113

+ “getContactHistoryFilterRequest” on page 115

+ “getCustomListRequest” on page 127

+ “getDeltasRequest” on page 128

+ “getDeltalnfoRequest” on page 131
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+ “getDiskSpaceUsageRequest” on page 133
+ “getDocumentTypelistRequest” on page 134
+ “getFolderRequest” on page 136

+ “getFolderListRequest” on page 138

+ “getFreeBusyRequest” on page 143

+ “getltemRequest” on page 146

+ “getltemsRequest” on page 148

+ “getJunkEntriesRequest” on page 154

+ “getJunkMailSettingsRequest” on page 156
+ “getlibraryltemRequest” on page 158

+ “getlibraryListRequest” on page 160

+ “getMemberOfRequest” on page 161

+ “getNotifyListRequest” on page 163

+ “getProxyAccessListRequest” on page 165
+ “getProxyListRequest” on page 167

+ “getQuickMessagesRequest” on page 169
+ “getRulelistRequest” on page 173

+ “getSettingsRequest” on page 176

+ “getSignaturesRequest” on page 184

+ “getStringRequest” on page 186

+ “getTimestampRequest” on page 187

+ “getTimezonelistRequest” on page 189

+ “getUnreadRequest” on page 191

+ “getUserListRequest” on page 195

+ “loginRequest” on page 197

+ “logoutRequest” on page 202

+ “markPrivateRequest” on page 203

+ “markReadRequest” on page 204

+ “markUnPrivateRequest” on page 205

+ “markUnReadRequest” on page 206

+ “modifyltemRequest” on page 207

+ “modifyltemsRequest” on page 211

+ “modifyJunkEntryRequest” on page 212

+ “modifyJunkMailSettingsRequest” on page 213
+ “modifyPasswordRequest” on page 214

+ “modifyNotifyRequest” on page 215

+ “modifyProxyAccessRequest” on page 216

+ “modifySettingsRequest” on page 218
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“modifySignaturesRequest” on page 219
“moveltemRequest” on page 220
“moveltemsRequest” on page 222
“positionCursorRequest” on page 224
“purgeDeletedltemsRequest” on page 226
“purgeRequest” on page 227
“readCursorRequest” on page 228
“removeCustomDefinitionRequest” on page 230
“removeltemRequest” on page 232
“removeltemsRequest” on page 233
“removelunkEntryRequest” on page 235
“removeMembersRequest” on page 236
“removeProxyAccessRequest” on page 237
“removeNotifyRequest” on page 238
“removeSignatureRequest” on page 239
“replyRequest” on page 240
“resendRequest” on page 242
“resolveRequest” on page 248
“restoreltemRequest” on page 249
“retractRequest” on page 250
“sendltemRequest” on page 252
“setTimestampRequest” on page 254
“startFreeBusySessionRequest” on page 256
“streamedSearchRequest” on page 258
“stubltemRequest” on page 262
“unacceptRequest” on page 263
“unarchiveRequest” on page 264
“uncompleteRequest” on page 265

“updateversionStatusRequest” on page 266
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acceptRequest

Accepts items.

Request

<accept Request >
<itens/>
<conmment/ >
<accept Level / >
<recurrenceAl | | nstances/ >
<cont ai ner/>
<al arni >

</ accept Request >

Response

<accept Response>
<stat us>
<code>0</ code>
</ status>
</ accept Response>

Elements

items

Specifies a list of item IDs to be accepted.

comment

Specifies text that the sender of the item can view in the send item properties.

acceptlLevel
Specifies how you want your appointments to appear in busy searches:
* Free
¢ Tentative
* Busy
Out of Office

*

recurrenceAllinstances

Specifies that you want the accept and its options to be applied to all recurring items if you pass
the recurrenceKey.

code

Returns the error number related to the event. 0 indicates that the request was successful.

status

Returns the success or failure of the method.
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container

Specifies the calendar/container as the destination for the accepted calendar item.

alarm

Specifies the alarm value.

Example

<accept Request >
<itens>
<i t emP40ADFA62. Aut oDomai n. Aut oPQOL. 100. 16F3471. 1. FEC. 1@: 7.
Aut oDomai n. Aut oPO1. 100. 0. 1. 0. 1@L6</i tenw
<litens>
<comment >This is a comment </ coment >
<accept Level >Tent ati ve</ accept Level >
<recurrenceAl | | nst ances>532</recurrenceAl | | nst ances>
</ accept Request >
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acceptShareRequest

Accepts a shared folder notification or a shared personal address book notification.

Request

<accept Shar eRequest >
<id/>
<nane/ >
<cont ai ner/ >
<descri ption/ >
<sequence/ >

</ accept Shar eRequest >

Response

<accept Shar eResponse>
<idl>
<status/>

</ accept Shar eResponse>

Elements
id
Specifies the ID of the shared folder notification to accept.

name

Specifies the name of the folder to create. If no name is given, the original name from the
notification message is used.

container

Specifies the container ID of the parent folder where the new folder is created. If the container
is not specified, the cabinet folder is the default container.

description

(optional) Specifies a detailed description of the shared folder. This is text supplied by the
creator of the shared folder.

sequence

Specifies where to place the new folder in the sequence of folders.

code

Returns the error number related to the event. 0 indicates that the request was successful.
Returns the ID for the newly created folder.

status

Returns the success or failure of the method.
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Example

<accept Shar eRequest >
<i d>44F71EE4. donai nl. pol. 100. 16E3837. 1. F86. 1@7: 7.
domai nl. pol.100.0. 1. 0.1@6</id>
<name>Shar ed Fol der for project A</ nane>
<cont ai ner >C. donmi nl. pol. 100. 0. 1. 0. 1@1</ cont ai ner >
<descri pti on>Shared Fol der Description</description>
</ accept Shar eRequest >

<accept Shar eResponse>

<i d>44F71F5C. donai nl1. pol. 100. 16E3837. 1. F87. 1@4: 44F71EE1.

domai nl. pol. 100. 1676834. 1. 766. 1</i d>
<stat us>
<code>0</ code>
</ st at us>
</ accept Shar eResponse>
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additemRequest

Adds an existing address book item (such as a contact, resource, organization, or group) to a
different personal address book. The item is also called a linked item because the original address
book item is not deleted. The user's database has one item that is referenced by many personal
address books.

Request

<addl t enRequest >
<cont ai ner/ >
<idl>

</ addl t enRequest >

Response

<addl t enResponse>
<status/>
</ addl t enResponse>

Elements

container

Specifies the ID of the destination personal address book.

Specifies the item ID that is to be linked to another personal address book.

code

Returns the error number related to the event. 0 indicates that the request was successful.

status

Returns the success or failure of the method.

Example

<addl t enRequest >
<cont ai ner >44F83F1D. domai nl. pol. 104. 16E3837. 1. F8. 1@3<cont ai ner >
<i d>44F83F50. domai nl. pol. 104. 16E3837. 1. FA. 1@®6: 42C510EA.
domai nl. pol. 104. 16E3837. 1. 3. 1@®3<i d>
</ addl t enRequest >
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addltemsRequest

Adds existing address book items (such as contacts, resources, organizations, and groups) to a
different personal address book. The item is also called a linked item because the original address
book items are not deleted. The user's database has several items that are referenced by many
personal address books.

Request

<addl t ensRequest >
<cont ai ner/ >
<itens/>

</ addl t ensRequest >

Response

<addl t ensResponse>
<status/>
</ addl t ensResponse>

Elements

container

Specifies the ID of the destination personal address book.

items

Specifies the items that are to be linked to another personal address book.

code

Returns the error number related to the event. 0 indicates that the request was successful.

status

Returns the success or failure of the method.

Example

<addl t ensRequest >
<cont ai ner >44F83F1D. domai nl. pol. 104. 16E3837. 1. F8. 1@®3</ cont ai ner >
<itens>
<i t enP44F855F7. domai nl. pol. 104. 16E3837. 1. FD. 1@®7: 42C510EA.
domai nl. pol. 104. 16E3837. 1. 3. 1@®3</itenp
<i t enP44F855E9. domai nl. pol. 104. 16E3837. 1. FC. 1@®5: 42C510EA.
domai nl. pol. 104. 16E3837. 1. 3. 1@®3</itenp
<litens>
</ addl t ensRequest >
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addMembersRequest

Adds existing address book items (such as contacts, resources, organizations, and groups) to an
existing personal address book group.

Request

<addMenber sRequest >
<cont ai ner/ >
<nenbers/ >

</ addMenber sRequest >

Response

<addMenber sResponse>
<status/>
</ addMenber sResponse>

Elements

container

Specifies the ID of the group.

members

Points to existing personal address book items to add to the group that is specified in the
container element.

The GroupMember element provides parameters that are not used. For example, the name
element can be set in the GroupMember element. However, the item name on the actual
personal address book item is not changed.

code

Returns the error number related to the event. 0 indicates that the request was successful.

status

Returns the success or failure of the method.

Example

<addMenber sRequest >
<cont ai ner >44EB3142. domai nl. pol. 104. 16E3837. 1. FO. 1@8: 44F83F1D.
domai nl. pol. 104. 16E3837. 1. F8. 1@®3</ cont ai ner >
<menber s>
<nmenber >
<i d>44EB3142. donmi nl. pol. 104. 16E3837. 1. FO. 1@8: 42C510EA.
dormai nl. pol. 104. 16E3837. 1. 3. 1@®3</i d>
<di st Type>TO</ di st Type>
</ menber >
</ menber s>
</ addMenber sRequest >
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archiveRequest

Archives item(s) to an archive database. The archive path needs to be a path that the POA has access
to (or can reach).

Request

<ar chi veRequest >
<itens/>
<pat h/ >

</ ar chi veRequest >

Response

<ar chi veResponse>
<pat h/ >
<status/>

</ ar chi veResponse>

Elements

items

Specifies the items to archive.

path

On input, specifies the path to use to create the archive directory. If a path is not specified, the
POA oftemp directory is used.

On output, returns the path to the archive directory is used.

code

Returns the error number related to the request. 0 indicates that the request was successful.

status

Returns the success or failure of the method.
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Example

<ar chi veRequest >
<itens>
<i t emp4D37DDE2. dorai n. PO3. 100. 16A7363. 1. 23E. 1@.:
7.domai n. PG3. 100.0.1.0.1@6</itenr
</itens>
<pat h>/ shr/ ar chi ve</ pat h>
</ ar chi veRequest >

<ar chi veResponse>
<pat h>/ shr/ ar chi ve/ of r awar c</ pat h>
<stat us>
<code>0</ code>
</ st at us>
</ ar chi veResponse>

<get Ar chi vel t emsRequest >
<cont ai ner >f ol der s</ cont ai ner >
<count >0</ count >
<pat h>/ shr/ ar chi ve/ </ pat h>

</ get Ar chi vel t emsRequest >

<get Ar chi vel t emsResponse>
<itens>
<itemtype="Mil">

<i d>4D37DE41. domai n. PG3. 100. 16A7363. 1. 17.1@.: 7. domai n. PG3. 100. 0. 1. 0. 1@ 6</
i d>
<si d>23</si d>
<ver si on>3</ versi on>
<nodi fi ed>2011- 01-20T14: 03: 29Z</ nodi fi ed>
<cont ai ner >7. domai n. PG3. 100. 0. 1. 0. 1@L6</ cont ai ner >
<creat ed>2011- 01- 20T14: 01: 54Z</ cr eat ed>
<stat us>
<opened>1</ opened>
<read>1</read>
</ st at us>
<msgl d>4D37DE41. domai n. PC3. 200. 2000000. 1. 3. 1</ nmsgl d>
<cli ent Messagel d>4D384052. CD9 : 4 : 31797</cli ent Messagel d>
<sour ce>r ecei ved</ sour ce>
<del i ver ed>2011- 01- 20T14: 01: 54Z</ del i ver ed>
<security>Normal </ security>
<subj ect >t 0 ar chi ve</ subj ect >
<di stri bution>
<fronp
<di spl ayNanme>Layne |zatt </ di spl ayName>
<emai | >l i zatt @r est ons. provo. novel | . conx/ enai | >
<uui d>FBC97000- 100A- 0000- 90B7- 0659E3122263</ uui d>
</fronp
<to>Layne |zatt</to>
<sendopt i ons>
<st at usTr acki ng>None</ st at usTr acki ng>
</ sendopt i ons>
</distribution>
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<options>
<priority>Standard</priority>
</ options>
<si ze>936</ si ze>
<t hr eadi ng>
<i d>4D37DDE2. dommi n. PC3. 200. 2000004. 1. 5D. 1:
4D37DE41. domai n. PG3. 200. 2000000. 1. 3. 1</i d>
<par ent >4D37DDE2. donai n. PC3. 200. 2000004. 1. 5D. 1</ par ent >
</t hr eadi ng>
<retentionhdified>2011-01-20T14: 03: 29Z</ret enti onModi fi ed>
<[itenp
</items>
<st at us>
<code>0</ code>
</ status>
</ get Archi vel t ensResponse>

<unar chi veRequest >
<items>
<i temr4D37DE41. domai n. PC3. 100. 16A7363. 1. 17. 1@.:
7. domai n. PC3. 100.0. 1. 0. 1@6</itenr
<items>
<pat h>/ shr/ ar chi ve</ pat h>
</ unar chi veRequest >

<unar chi veResponse>
<pat h>/ shr/ ar chi ve/ of r awar c</ pat h>
<st at us>
<code>0</ code>
</ status>
</ unar chi veResponse>
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closeFreeBusySessionRequest

Frees server-side resources that are created by calling startFreeBusySessionRequest.
startFreeBusySessionRequest returns a freeBusySessionld that points to the server-side free/busy
resource. This method should be called when all the free/busy information has been returned.

Request

<cl oseFr eeBusySessi onRequest >
<freeBusySessi onl d/ >
</ cl oseFr eeBusySessi onRequest >

Response

<cl oseFr eeBusySessi onResponse>
<status/>
</ cl oseFr eeBusySessi onResponse>

Elements

freeBusySessionld
Points to the server-side FreeBusy resource that was returned in the
startFreeBusySessionResponse.

code

Returns the error number related to the event. 0 indicates that the request was successful.

status

Returns the success or failure of the method.

Example

<cl oseFr eeBusySessi onRequest >
<f reeBusySessi onl d>354</f r eeBusySessi onl d>
</ cl oseFr eeBusySessi onRequest >

<cl oseFr eeBusySessi onResponse>
<stat us>
<code>0</ code>
</ st atus>
</ cl oseFr eeBusySessi onResponse>
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completeRequest

Marks a task as complete.

Request

<accept Request >
<itens/>
<conmment/ >
<accept Level / >
<recurrenceAl | | nstances/ >
</ accept Request >

Response

<accept Response>
<stat us>
<code/ >
</ status>
</ accept Response>

Elements

items

Specifies a list of item IDs to accept.

code

Returns the error number related to the event. 0 indicates that the request was successful.

status

Returns the success or failure of the method.

Example

<conpl et eRequest >
<itens>
<i t emp44FD563E. domai nl. pol. 100. 16E3837. 1. F8B. 1@3:
7.domai nl. pol.100.0.1.0.1@6
</itenp
</itens>
</ conpl et eRequest >
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createCursorRequest

Creates a server-side cursor resource for retrieving large amounts of container data in small chunks
and allows you to read containers (such as a mailbox folder or an address book). If a
createCursorRequest is successful, destroy the server-side cursor resource by calling
destroyCursorRequest. For more information please see Getting Items.

Request

<creat eCur sor Request >
<cont ai ner/ >
<vi ew >
<filter/>

</ cr eat eCur sor Request >

Response

<cr eat eCur sor Response>
<cursor/>
<st at us/ >

</ cr eat eCur sor Response>

Elements

container

Specifies the container's ID. If the container is empty, the cursor reads all folders in the user’s
database (with the exception of the shared folders shared with the user, the query folders and
the Trash folder).

view

Specifies the elements that are returned for each item. The view reduces the amount of data
returned. If a view is not specified, all elements are returned.

filter

Specifies restrictions on the items to read.

cursor

Specifies the server-side cursor resource. The cursor ID can be used with other cursor methods
such as positionCursorRequest, readCursorRequest, and destroyCursorRequest.

code

Returns the error number related to the event. 0 indicates that the request was successful.

status

Returns the success or failure of the method.
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Example

<cr eat eCur sor Request >
<cont ai ner >19. donai nl. pol. 100. 0. 1. 0. 1@0</ cont ai ner >
<vi ew>i d nessagel d subject nessage recipients</view>
<filter>
<el ement type="FilterEntry">
<op>gt </ op>
<field>created</field>
<val ue>2012- 08- 15T00: 00: 00Z</ val ue>
</ el emrent >
</filter>
</ cr eat eCur sor Request >

<cr eat eCur sor Response>
<cur sor>1195551863</ cur sor >
<st at us>
<code>0</ code>
</ status>
</ cr eat eCur sor Response>

Methods

89



createltemRequest

Creates mail, appointment, tasks, notes, and phone items in a mailbox without sending out the item
to other users. If you need to send personal, posted, or distributed items, call sendltemRequest.

Request

<creat el t emRequest >
<item >
<notification/>

</ createltenRequest >

Response

<creat el tenResponse>
<id/>
<status/>

</ createltenResponse>

Elements
item
Specifies the item to create.

notification

Specifies the information that is used in a shared folder or personal address book notification

message.
id
On a successful response, specifies the ID of the newly created item. Recurring items return an
ID for each item that was created.
code
Returns the error number related to the event. 0 indicates that the request was successful.
status
Returns the success or failure of the method.
Remarks

The createltemRequest method is used to create the following item types:

+ Address Book Items:
+ Contacts
* Groups
+ Organizations
+ Personal Address Books

+ Resources
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+ Categories

+ Folders

¢ Rules

+ Shared Folders

+ Mail Items
+ Mail Messages
+ Appointments
* Tasks
+ Notes

+ Phone Messages

Example

<creat el t emRequest >
<itemtypes="Contact">
<cont ai ner >406901A0. pr ovo. resear ch. 104. 16C3230. 1. 3. 1@3</ cont ai ner >
<categories types: primry="1.provo.research.100.0.1.0. 1@1"
<cat egory>4. provo. research. 100. 0. 1. 0. 1@1</ cat egory>
<cat egory>1. provo. research. 100.0. 1. 0. 1@1</ cat egory>
</ cat egori es>
<f ul I Name>
<di spl ayName>John Doe</ di spl ayNane>

<firstName>John</first Nane>
<l ast Nane>Doe</ | ast Nane>

</ ful | Nane>

<emai | Li st primary="jdoe@ovell . conf
<enai | >j doe@wovel |l . conx/ emai | >

</ emai | Li st>

<emui | >j doe@ovel |l . conx/ emai | >

</types:itenp

</ createltenRequest >

<createl tenResponse>
<i d>407D48DF. provo. resear ch. 104. 16C3230. 1. 7D. 1@6</i d>
<st at us>
<code>0</ code>
</ status>
</ createltenResponse>
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createltemsRequest

Is similar to createltemRequest. The only difference is that createltemsRequest can create more than
one item at a time.
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createJunkEntryRequest

Provides access to the junk mail handling, block, and trust lists for a user.

Request

<creat eJunkEnt r yRequest >
<entry/>
</ cr eat eJunkEnt r yRequest >

Response

<cr eat eJunkEnt r yResponse>
<idl>
<stat us>
<code/ >
</ status>
</ cr eat eJunkEnt r yResponse>

Elements

entry

Specifies the new junk mail handling entry.

On a successful response, specifies the ID of the newly created junk mail entry.

code

Returns the error number related to the event. 0 indicates that the request was successful.

status

Returns the success or failure of the method.

Example

<creat eJunkEnt r yRequest >
<entry>
<mat ch>user 2@l ock. net </ mat ch>
<mat chType>enai | </ mat chType>
<list Type>bl ock</Ii st Type>
<l ast Used />
<ver si on>0</ ver si on>
</entry>
</ cr eat eJunkEnt r yRequest >

<creat eJunkEnt r yResponse>
<i d>44FE8B4B. domai nl1. pol. 104. 16E3837. 1. 106. 1@6</ i d>
<st at us>
<code>0</ code>
</ st at us>
</ cr eat eJunkEnt r yResponse>
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createNotifyRequest

Creates a notify entry. In the GroupWise Windows client, you can set up to be notified for another
persons alarms and deliveries (see “Being Notified of Someone Else's Messages” (http://
www.novell.com/documentation/groupwise2012/gw2012_guide_userwin/data/aai3cls.html). The
createNotifyRequest, getNotifyListRequest, modifyNotifyRequest and removeNotifyRequest are
used to manage these settings. --For GroupWise 8.0 SP1 and later.

Request

<createNoti f yRequest >
<entry/>
</ createNotifyRequest >

Response

<createNotifyResponse>
<idl>
<st at us/>

</ createNotifyResponse>

Elements

entry

Specifies the user and notification options.

On a successful response, specifies the ID of the NotifyEntry.

code

Returns the error number related to the request. 0 indicates that the request was successful.

status

Returns the success or failure of the request.
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Example

<createNoti f yRequest >
<entry type="NotifyEntry">
<di spl ayName>Jay Par ker </ di spl ayNane>
<emi | >j par ker @r est ons. provo. novel | . conx/ emai | >
<uui d>C974CA00- 0B55- 0000- B976- BEQOE5B002BD</ uui d>
<ri ght s>
<al arnpt rue</ al ar me
<notification>true</notification>
</rights>
</entry>
</ createNotifyRequest >

<createNoti f yResponse>
<i d>4D3D6590. donai n. POL. 100. 1776172. 1. 25C8C. 1@8</ i d>
<stat us>
<code>0</ code>
</ st at us>
</ createNotifyResponse>
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createProxyAccessRequest

Allows a user to grant access to his or her mailbox to another user.

Request

<cr eat ePr oxyAccessRequest >
<entry/>
</ cr eat ePr oxyAccessRequest >

Response

<creat eProxyAccessResponse>
<id/>
<status/>

</ cr eat eProxyAccessResponse>

Elements

entry

Specifies the user to grant access to and the access rights he or she has to the mailbox.

On a successful response, specifies the ID of the AccessRightEntry.

code

Returns the error number related to the event. 0 indicates that the request was successful.

status
Returns the success or failure of the method.

Remarks

The user can limit the type of access a proxy has by using access rights. For example, users could
specify that another user has read or write access to mail, appointments, tasks, notes, alarms,
notifications, options, and private items.
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Example

<cr eat eProxyAccessRequest >
<entry>

<di spl ayName>u4</ di spl ayNanme>

<emai | >u4@hant om conx/ emai | >

<uui d>66301550- 175B- 0000- 890F- 6EO0D5004E00</ uui d>

<appoi nt nent >
<read>1</read>
<wite>l</wite>

</ appoi nt ment >

<mai | >
<read>1</read>
<wite>l</wite>

</ mil >

<m sc>
<al arns>1</ al ar ns>
<notify>l</notify>
<readH dden>1</readH dden>
<set up>1</set up>

</ m sc>

<not e>
<read>1</read>
<wite>l</wite>

</ not e>

<t ask>
<read>1</read>
<wite>l</wite>

</task>

</entry>
</ cr eat eProxyAccessRequest >
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createSignatureRequest

Creates a new signature for a user. It returns a signature ID after it successfully completes. HTML
signatures are stored as a MIME type, according to the MIME (RFC822) standard for storing
signatures.

Request

<cr eat eSi gnat ur eRequest >
<si gnature/>
</ cr eat eSi gnat ur eRequest >

Response

<creat eSi gnat ur eResponse>
<status/>
</ cr eat eSi gnat ur eResponse>

Elements

signature

Specifies the signature to be created.

code

Returns the error number related to the event. 0 indicates that the request was successful.

status

Returns the success or failure of the method.
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declineRequest

Declines items.

Request

<decl i neRequest >
<itens/>
<conmment/ >
<recurrenceAl | | nstances/ >
</ decl i neRequest >

Response

<decl i neResponse>
<stat us>
<code/ >
</ status>
</ decl i neResponse>

Elements
items
Specifies a list of item IDs to be declined.

comment

Specifies text that the sender of the item can view in the properties of the sent item.

recurrenceAllinstances

Specifies the recurrenceKey so that the decline and its options can be applied to all the
recurring items.

code

Returns the error number related to the event. 0 indicates that the request was successful.

status

Returns the success or failure of the method.

Example

<decl i neRequest >
<itens>
<i t enP44FED4BA. domai nl. pol. 100. 16E3837. 1. FOD. 1@4: 7.
domai nl. pol. 100.0. 1. 0. 1@6</itenr
</itens>
<conment >asdf </ comrent >
<recurrenceAl | | nst ances>36167</recurrenceAl | | nst ances>
</ decl i neRequest >
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delegateRequest

Delegates calendar items (appointments, notes, and tasks) to other users.

Request

<del egat eRequest >
<id type="types:uid"/>
<conment ToOr gani zer type="string"/>
<conment ToDel egat ee type="string"/>
<di stribution type="types:Distribution"/>
<recurrenceAl | | nstances type="recurrenceKey"/>
</ del egat eRequest >

Response

<del egat eResponse>
<status type="types: Status"/>
</ del egat eResponse>

Elements

id
Specifies the ID of the item to be delegated.

commentToOrganizer
Specifies a comment that the sender of the original calendar item can view in the properties of
the sent item.

commentToDelegatee

Specifies a comment to the delegatee of the item. This element is not used by any GroupWise
client.

distribution

Specifies the recipients for the delegated calendar item.

recurrenceAlllnstances

Specifies the recurrenceKey so that the delegate and its options can be applied to all the
recurring items.

code

Returns the error number related to the event. 0 indicates that the request was successful.

status

Returns the success or failure of the method.
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Example

<del egat eRequest >
<i d>44FED73B. donai nl. pol. 100. 16E3837. 1. FAA. 1@: 7.
domai nl. pol.100.0.1.0.1@6</id>
<conmment ToOr gani zer >Coment to Organi zer </ conment ToOr gani zer >
<conmment ToDel egat ee>Comment to Del egat ee</ conment ToDel egat ee>
<di stri buti on>
<r eci pi ent s>
<r eci pi ent >
<di spl ayName>u3</ di spl ayNane>
<emai | >u3@hant om conx/ emai | >
<uui d>54D55590- 175B- 0000- 890F- 6E00D5004E00</ uui d>
</ recipient>
</ recipients>
</ distribution>
</ del egat eRequest >
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destroyCursorRequest

Deletes the server-side cursor resource that was created by the createCursorRequest method. For
more information please see Getting Items.

Request

<dest r oyCur sor Request >
<cont ai ner type="types:uid"/>
<cursor type="int"/>

</ dest r oyCur sor Request >

Response

<dest r oyCur sor Response>
<status type="types: Status"/>
</ dest or yCur sor Response>

Elements
container
Specifies the container for the server-side cursor.

cursor

Specifies the identifier for the server-side cursor resource that is to be deleted.

code

Returns the error number related to the event. 0 indicates that the request was successful.

status

Returns the success or failure of the method.
Example
<dest r oyCur sor Request >
<cont ai ner >19. donai nl. pol. 100. 0. 1. 0. 1@0</ cont ai ner >

<cursor>1195457801</ cur sor >
</ dest r oyCur sor Request >
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executeRuleRequest

Immediately runs or executes a previously defined rule.

Request
<execut eRul eRequest >

<id type="types:uid"/>
</ execut eRul eRequest >

Response

<execut eRul eResponse>
<status type="types: Status"/>
</ execut eRul eResponse>

Elements
id
Points to the rule to be executed.

code

Returns the error number related to the event. 0 indicates that the request was successful.

status

Returns the success or failure of the method.

Example

<execut eRul eRequest >

<i d>44630E88. donai nl1. pol. 100. 16E3837. 1. B5E. 1@0</i d>

</ execut eRul eRequest >
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forwardRequest

Forwards an existing item to other users.

Request

<f orwar dRequest >
<id type="types:uid"/>
<view type="string"/>
<enbed type="bool ean"/ >
</ f orwar dRequest >

Response

<f orwar dResponse>
<itemtype="types:Iten/>
<status type="types: Status"/>
</ f orwar dResponse>

Elements

id
Specifies the ID of the item you want to forward.

view
Specifies if you want the original message body returned in the forward method. If you do,
supply “message” or “message/RTF” in the view.

embed

Specifies if the original item is to be sent as an attachment in the new mail item. If you do, pass
True in the embed element in the forwardRequest. Otherwise, pass False.

If you set embed to true, you need to make sure the view on forwardRequest does not contain
the "attachments" keyword. The forwardResponse will then send down an attachment
structure that needs to be added to the new item.

item

Specifies a returned item that can be modified and passed to the sendRequest method to
complete the forwardRequest.

code

Returns the error number related to the event. 0 indicates that the request was successful.

status

Returns the success or failure of the method.

Methods



Remarks

Forwarding a message is a two-step process.

The first step is to call forwardRequest with the ID of the item that you want to forward. A new mail
item is then returned with the original subject and other fields defined in the view. You can modify
this returned item. For example, the caller might want to prepend “Fwd:” to the beginning of the
subject. The message body and other fields can also be modified and attachments added. The
linkInfo element is returned with this item.

The second step is to call sendRequest with the modified mail item. The linkinfo element needs to be
passed unchanged in the sendRequest. The linkinfo element is necessary for the POA to link the
original item with the new item using the sendRequest.

Example

<f orwar dRequest >

<i d>44FEDD14. dorai nl. pol. 100. 16E3837. 1. FB2. 1@: 7. domai nl. pol. 100. 0. 1. 0. 1@
6</id>

<vi ew>subj ect id message</vi ew>

<enbed>f al se</ enbed>

</ f orwar dRequest >

<f or war dResponse>

<itenp

<sour ce>sent </ sour ce>
<subj ect >New Appt 1</ subject >
<nessage>

<part content Type="text/plain"

| engt h="64">YXNkZgogCi AKVXNI ci AxCi AgTnB2ZWksl El uYy4gl Aogl CAAN Et MTEzMCAgl A
o=</part>

</ nessage>

<attachnent s>

<attachnent >

<id itenReference="1">4018</id>
<nane>F| LE</ name>

<cont ent Type>Appoi nt ment </ cont ent Type>
<hi dden>1</ hi dden>

</ attachnent >

</ attachnent s>

<li nk>

<i d>0:4018</i d>

<t ype>f orwar d</t ype>

</link>

</itenp

<st at us>

<code>0</ code>

</status>

</ f orwar dResponse>
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getAccountListRequest

Returns the list of accounts.

Request

<"get Account Li st Request ">

Response

<get Account Li st Response>
<account type="types:IltenList"/>
<status type="types: Status"/>

</ get Account Li st Response>

Elements

accounts

A list of accounts.

status

Returns the success or failure of the method.
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getAddressBookListRequest

Returns the list of address books.

Request

<get Addr essBookLi st Request >
<nane type="string"/>
<view type="string"/>

</ get Addr essBookLi st Request >

Response

<get Addr essBookLi st Response>
<books type="types: Addr essBookLi st"/>
<status type="types: Status"/>

</ get Addr essBookLi st Response>

Elements

books
Returns the list of personal address books and the ID of the GroupWise Address Book.

code

Returns the error number related to the event. 0 indicates that the request was successful.

status

Returns the success or failure of the method.

name
Specify the name of the book to return.
view

Specifies the elements that are returned for each item. The view reduces the amount of data
returned. If a view is not specified, all elements are returned.
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Example
<get Addr essBookLi st Request />

<get Addr essBookLi st Response>
<books>

<book>
<i d>42C510EA. donmi nl. pol. 104. 16E3837. 1. 1. 1@®3</i d>
<nane>Fr equent Cont act s</ name>
<versi on>2</ versi on>
<nodi fi ed>2005- 07- 01T15: 46: 18Z</ nodi fi ed>
<i sPer sonal >1</i sPer sonal >
<i sFrequent Cont act s>1</i sFrequent Cont act s>

</ book>

<book>
<i d>G oupW seSyst emAddr essBook @2</ i d>
<nanme>Novel | G oupW se Address Book</nane>

</ book>

<book>
<i d>44F83F1D. domai nl. pol. 104. 16E3837. 1. F8. 1@®3</i d>
<nanme>New Book</ nane>
<versi on>2</ versi on>
<nodi fi ed>2012- 09- 01T20: 09: 33Z</ nodi fi ed>
<i sPer sonal >1</i sPer sonal >

</ book>

<book>
<i d>42C510EA. donmi nl. pol. 104. 16E3837. 1. 3. 1@3</i d>
<nane>ul</ nane>
<ver si on>9</ versi on>
<nodi fi ed>2012- 08- 23T15: 53: 54Z</ nodi f i ed>
<i sPer sonal >1</i sPer sonal >

</ book>

</ books>
</ get Addr essBookLi st Response>
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getArchiveltemsRequest

Returns items from the specified archive database.

Request

<cont ai ner type="types:uid" />
<view type="types: View'/ >
<filter type="types:Filter" />
<itenms type="types:ItenReflList" />
<count type="int" />
<path type="string" />

</ get Ar chi vel t emsRequest >

Response

<get Ar chi vel t emsResponse>
<items type="types:ltens />
<status type="types: Status" />
</ get Archi vel t emsResponse>

Elements

container
(optional) Specifies the folder, address book, or library container ID. If the container is not
specified, the filter is used. If the filter is not present, an error is returned.

view

Specifies the elements returned for each item. The view reduces the amount of data returned. If
a view is not specified, all item elements are returned.

filter

Specifies the items to return based on a filter.

items
On input, specifies a list of item ids to return.

On return, returns the specified items.

count

Specifies the number of items to return. If the count element is -1, all items are returned.

path
Specifies the path to the archive directory. If not specified, the POA oftemp directory is used.

code

Specifies the error number related to the event. 0 indicates that the request was successful.

status

Returns the success or failure of the method.
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Example

See archiveRequest.
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getAttachmentRequest

Returns the selected file attachment. It does not read embedded GroupWise items such as mail
messages or appointments.

Request

<get At t achment Request >

<id type="types:uid"/>

<of fset type="int"/>

<length type="int"/>

<flags type="types: Attachnent Fl ags"/ >
</ get At t achment Request >

Response

<get At t achnent Response>
<part type="types: MessagePart"/>
<status type="types: Status"/>

</ get At t achnment Response>

Elements
id
Specifies the ID of the attachment to read.

offset

Specifies the starting position for reading the attachment.

length

Specifies the number of bytes to read from the offset.

part

Specifies the attachment.

code

Returns the error number related to the event. 0 indicates that the request was successful.

status

Returns the success or failure of the method.

flags
Specifies the attachment flags.

Remarks

To retrieve the entire file in one read, specify an offset of 0 with a length of -1. If you have a large file,
you can read the attachment in chunks by using the offset element to position the attachment
reader and specifying the length of the chunk’s size.
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Example

<get At t achment Request >
<i d>45003893. donai n1. pol. 200. 20000CB. 1. 1530. 1@15: 45003893.
domai nl. pol. 100. 16E3837. 1. FBA. 1@.: 7.
domai nl. pol.100.0. 1. 0.1@6</id>
<of f set >0</ of f set >
<l engt h>- 1</ | engt h>
</ get At t achment Request >

<get Att achrment Response>

<part | ength="164"of f set="122">

MS4gl FNhdmJgTO9PI GFz1 HRl eHQgZm sZXMgbmv4dCBOaWLl LgOKM 4gl E
uY2x1ZGUgdGhl | EJI ZXAgY2xpZWe0DQozLi AgRA zY3VzcyB2ZXJzaWuaWb
nLgOKNCAgl E51 dEJI YWz DUUMCBCZXRhI DI NG Uul CA=</ part >
<stat us>
<code>0</ code>

</ st at us>

</ get At t achment Response>
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getCategoryListRequest

Returns the list of categories for the user.

Request

<get Cat egor yLi st Request />

Response

<get Cat egor yLi st Response>
<categories type="types: CategorylList"/>
<status type="types: Status"/>

</ get Cat egor yLi st Response>

Elements

Categories

Returns the list of categories defined by the user.

code

Returns the error number related to the event. 0 indicates that the request was successful.

status

Returns the success or failure of the method.

Example
<get Cat egor yLi st Request />

<get Cat egor yLi st Response>
<cat egori es>

<cat egory>
<i d>4. Aut oDonmi n. Aut oPCL. 100. 0. 1. 0. 1@®1</i d>
<nane>Low priority</nanme>
<versi on>1</versi on>
<nodi fi ed>2002- 10- 02T23: 17: 10Z</ modi f i ed>
<type>LowPriority</type>
<col or >12632256</ col or >

</ cat egory>

<cat egory>
<j d>3. Aut oDomai n. Aut oPOL. 100. 0. 1. 0. 1@1</i d>
<nane>Ur gent </ name>
<ver si on>1</versi on>
<nodi fi ed>2002- 10- 02T23: 17: 10Z</ nodi f i ed>
<t ype>Urgent </t ype>
<col or >255</ col or >

</ cat egory>

<cat egory>
<j d>2. Aut oDomai n. Aut oPOL. 100. 0. 1. 0. 1@1</i d>
<nane>Fol | ow up</ nane>
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<versi on>1</ ver si on>
<nodi fi ed>2002- 10-02T23: 17: 10Z</ nodi fi ed>
<t ype>Fol | ow up</type>
<col or >33023</ col or >
</ cat egory>
<cat egory>
<i d>1. Aut oDomai n. Aut oPO1. 100. 0. 1. 0. 1@®1</i d>
<name>Per sonal </ nane>
<versi on>2</ versi on>
<nodi fi ed>2002- 10- 30T14: 57: 09Z</ nodi fi ed>
<t ype>Per sonal </ type>
<col or>16711680</ col or >
</ cat egory>
<cat egory>
<i d>3D047D59. Aut oDonai n. Aut oPOL. 100. 1363230. 1. 435. 1@2</i d>
<name>Busi ness</ nane>
<ver si on>6</versi on>
<nodi fi ed>2004- 02- 19T15: 39: 08Z</ nodi fi ed>
<t ype>Nor mal </t ype>
</ cat egory>
<cat egory>
<i d>3DC90830. Aut oDomai n. Aut oPOL. 100. 1363230. 1. 511. 1@2</i d>
<nanme>Hone</ nane>
<versi on>1</versi on>
<nodi fi ed>2002- 11-06T19: 16: 48Z</ nodi fi ed>
<t ype>Nor mal </ type>
</ cat egory>
<cat egory>
<i d>3DBF94E2. Aut oDomai n. Aut oPOL. 100. 1363230. 1. 4F9. 1@2</i d>
<nane>Meet i ng</ name>
<versi on>3</versi on>
<nodi fi ed>2004- 02- 19T15: 39: 08Z</ nodi fi ed>
<t ype>Nor mal </t ype>
<col or>16711680</ col or >
</ cat egory>
</ cat egori es>
<st atus>
<code>0</ code>
</ status>
</ get Cat egor yLi st Response>
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getContactHistoryFilterRequest

This request returns the filter used in getting the contact history. The filter then can be used in a
getltemsRequest or with the cursor calls. --For GroupWise 2012 and later.

Request

<get Cont act Hi st oryFi | t er Request >
<id type="types:uid"/>
</ get Cont act Hi st oryFi | t er Request >

Response

<get Cont act Hi st or yFi | t er Response>
<filter type="types:Filter"/>
<status type="types: Status"/>

</ get Cont act Hi st oryFi | t er Response>

Elements

id
ID of the contact to generate the filter.

filter

Filter to use in getting the items associated with the contact.

code

Specifies the error number related to the event. 0 indicates that the request was successful.

status

Returns the success or failure of the method.

Example

<get Cont act Hi st oryFi | t er Request >
<i d>4625EDFB. donai n. POL. 104. 1776172. 1. BC. 1@6:
45080270. donai n. POL. 104. 1776172. 1. 3. 1@3</i d>
</ get Cont act Hi st oryFi | t er Request >

<get Cont act Hi st oryFi | t er Response>
<filter>
<el ement type="Filter G oup">
<op>or </ op>
<el ement type="FilterGoup">
<op>and</ op>
<el ement type="FilterGoup">
<op>or </ op>
<el ement type="FilterEntry">
<op>cont ai ns</ op>
<field>to</field>
<val ue>Prest on Stephenson</val ue>
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</ el enent >
<el ement type="FilterEntry">
<op>cont ai ns</ op>
<field>cc</fiel d>
<val ue>Prest on Stephenson</val ue>
</ el enent >
<el ement type="FilterEntry">
<op>cont ai ns</ op>
<field>bc</fiel d>
<val ue>Preston Stephenson</val ue>
</ el emrent >
<el ement type="FilterEntry">
<op>cont ai ns</ op>
<field>to</field>
<val ue>pst ephenson@r est ons. provo. novel | . conk/ val ue>
</ el emrent >
<el ement type="FilterEntry">
<op>cont ai ns</ op>
<field>cc</field>
<val ue>pst ephenson@r est ons. provo. novel | . conk/ val ue>
</ el emrent >
<el ement type="FilterEntry">
<op>cont ai ns</ op>
<field>bc</fiel d>
<val ue>pst ephenson@r est ons. provo. novel | . conk/ val ue>
</ el emrent >
<el ement type="FilterEntry">
<op>cont ai ns</ op>
<field>to</field>
<val ue>pst ephenson@st ephenson. provo. novel | . conx/ val ue>
</ el ement >
<el ement type="FilterEntry">
<op>cont ai ns</ op>
<field>cc</field>
<val ue>pst ephenson@st ephenson. provo. novel | . conx/ val ue>
</ el emrent >
<el ement type="FilterEntry">
<op>cont ai ns</ op>
<field>bc</fiel d>
<val ue>pst ephenson@st ephenson. provo. novel | . conx/ val ue>
</ el emrent >
</ el enent >
<el ement type="FilterG oup">
<op>or </ op>
<el ement type="FilterEntry">
<op>cont ai ns</ op>
<field>fronx/field>
<val ue>Preston Stephenson</val ue>
</ el ement >
</ el enent >

</ el enent >
<el ement type="FilterGoup">

<op>or </ op>
<el ement type="FilterEntry">
<op>cont ai ns</ op>



<field>fronx/field>
<val ue>Prest on Stephenson</val ue>
</ el enent >
<el ement type="FilterEntry">
<op>cont ai ns</ op>
<fiel d>aut hor</fiel d>
<val ue>Prest on Stephenson</val ue>
</ el enent >
<el ement type="FilterEntry">
<op>cont ai ns</ op>
<field>creator</field>
<val ue>Preston Stephenson</val ue>
</ el enent >
<el ement type="FilterEntry">
<op>cont ai ns</ op>
<field>fronx/fiel d>
<val ue>pst ephenson@r est ons. provo. novel I . conk/ val ue>
</ el enent >
<el ement type="FilterEntry">
<op>cont ai ns</ op>
<fiel d>aut hor</fiel d>
<val ue>pst ephenson@r est ons. provo. novel I . conk/ val ue>
</ el enent >
<el ement type="FilterEntry">
<op>cont ai ns</ op>
<field>creator</field>
<val ue>pst ephenson@r est ons. provo. novel | . conk/ val ue>
</ el enent >
<el ement type="FilterEntry">
<op>cont ai ns</ op>
<field>fronx/fiel d>
<val ue>pst ephenson@st ephenson. provo. novel | . conx/ val ue>
</ el enent >
<el ement type="FilterEntry">
<op>cont ai ns</ op>
<fiel d>aut hor</field>
<val ue>pst ephenson@st ephenson. provo. novel | . conx/ val ue>
</ el enent >
<el ement type="FilterEntry">
<op>cont ai ns</ op>
<field>creator</field>
<val ue>pst ephenson@st ephenson. provo. novel | . conx/ val ue>
</ el enent >
</ el enent >
<el ement type="FilterG oup">
<op>or </ op>
<el ement type="FilterEntry">
<op>cont ai ns</ op>
<field>ltenContact</field>
<value>.J H &quot;f &t;ar?! '} I</value>
</ el enent >
</ el enent >
</ el ement >
</filter>
<st at us>
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<code>0</ code>
</ st at us>
</ get Cont act Hi st oryFi | t er Response>

<creat eCur sor Request >
<cont ai ner >f ol der s</ cont ai ner >
<filter>
<el ement type="FilterG oup">
<op>or </ op>
<el enent type="Filter G oup">
<op>and</ op>
<el ement type="FilterG oup">
<op>or </ op>
<el ement type="FilterEntry">
<op>cont ai ns</ op>
<field>to</field>
<val ue>Preston Stephenson</val ue>
</ el enent >
<el ement type="FilterEntry">
<op>cont ai ns</ op>
<field>cc</field>
<val ue>Preston Stephenson</val ue>
</ el enent >
<el ement type="FilterEntry">
<op>cont ai ns</ op>
<field>bc</field>
<val ue>Preston Stephenson</val ue>
</ el enent >
<el ement type="FilterEntry">
<op>cont ai ns</ op>
<field>to</field>
<val ue>pst ephenson@r est ons. provo. novel | . conk/ val ue>
</ el enent >
<el ement type="FilterEntry">
<op>cont ai ns</ op>
<field>cc</field>
<val ue>pst ephenson@r est ons. provo. novel | . conk/ val ue>
</ el ement >
<el ement type="FilterEntry">
<op>cont ai ns</ op>
<field>bc</field>
<val ue>pst ephenson@r est ons. provo. novel I . conk/ val ue>
</ el ement >
<el ement type="FilterEntry">
<op>cont ai ns</ op>
<field>to</field>
<val ue>pst ephenson@st ephenson. provo. novel | . conx/ val ue>
</ el enent >
<el ement type="FilterEntry">
<op>cont ai ns</ op>
<field>cc</field>
<val ue>pst ephenson@st ephenson. provo. novel | . conx/ val ue>
</ el enent >
<el ement type="FilterEntry">
<op>cont ai ns</ op>
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<field>bc</fiel d>
<val ue>pst ephenson@st ephenson. provo. novel | . conx/ val ue>
</ el enent >
<el enent type="FilterEntry">
<op>cont ai ns</ op>
<field>to</field>
<val ue>pst ephenson@r est ons. provo. novel | . conx/ val ue>
</ el enent >
<el ement type="FilterEntry">
<op>cont ai ns</ op>
<field>cc</field>
<val ue>pst ephenson@r est ons. provo. novel | . conk/ val ue>
</ el enent >
<el ement type="FilterEntry">
<op>cont ai ns</ op>
<field>bc</field>
<val ue>pst ephenson@r est ons. provo. novel | . conk/ val ue>
</ el enent >
</ el enent >
<el ement type="FilterG oup">
<op>or </ op>
<el ement type="FilterEntry">
<op>cont ai ns</ op>
<field>fronx/fiel d>
<val ue>Preston Stephenson</val ue>
</ el enent >
</ el enent >
</ el enent >
<el ement type="FilterG oup">
<op>or </ op>
<el ement type="FilterEntry">
<op>cont ai ns</ op>
<field>fronx/fiel d>
<val ue>Preston Stephenson</val ue>
</ el ement >
<el ement type="FilterEntry">
<op>cont ai ns</ op>
<fiel d>aut hor</field>
<val ue>Preston Stephenson</val ue>
</ el enent >
<el ement type="FilterEntry">
<op>cont ai ns</ op>
<field>creator</field>
<val ue>Preston Stephenson</val ue>
</ el enent >
<el ement type="FilterEntry">
<op>cont ai ns</ op>
<field>fronx/fiel d>
<val ue>pst ephenson@r est ons. provo. novel | . conk/ val ue>
</ el enent >
<el ement type="FilterEntry">
<op>cont ai ns</ op>
<fiel d>aut hor</field>
<val ue>pst ephenson@r est ons. provo. novel I . conk/ val ue>
</ el enent >
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<el ement type="FilterEntry">
<op>cont ai ns</ op>
<field>creator</field>
<val ue>pst ephenson@r est ons. provo. novel | . conx/ val ue>
</ el enent >
<el ement type="FilterEntry">
<op>cont ai ns</ op>
<field>fronx/field>
<val ue>pst ephenson@st ephenson. provo. novel | . conx/ val ue>
</ el enent >
<el ement type="FilterEntry">
<op>cont ai ns</ op>
<fiel d>aut hor</field>
<val ue>pst ephenson@st ephenson. provo. novel | . conx/ val ue>
</ el enent >
<el ement type="FilterEntry">
<op>cont ai ns</ op>
<field>creator</field>
<val ue>pst ephenson@st ephenson. provo. novel | . conx/ val ue>
</ el enent >
</ el enent >
<el ement type="FilterG oup">
<op>or </ op>
<el ement type="FilterEntry">
<op>cont ai ns</ op>
<field>ltenContact</fiel d>
<value>.J H "f &t;ar? 1} I</value>
</ el enent >
</ el enent >
</ el emrent >
</filter>
</ creat eCur sor Request >

<creat eCur sor Response>
<cursor>1217918620</ cur sor >
<st at us>

<code>0</ code>

</ status>
</ creat eCur sor Response>

<r eadCur sor Request >

<cont ai ner >f ol der s</ cont ai ner >
<cursor>1217918620</ cur sor >

<f orwar d>t rue</f orwar d>

<posi ti on>current</position>
<count >0</ count >

</ readCur sor Request >

<r eadCur sor Response>
<items>
<item type="Task">
<i d>4D385ABA. donmi n. POL. 100. 1776172. 1. 25C6D. 1@3:
A. donmi n. PQL. 100. 0. 1. 0. 1@9</i d>
<si d>154733</ si d>
<versi on>7</versi on>
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<modi fi ed>2011-01-25T08: 00: 04Z</ nodi fi ed>
<cont ai ner sid="5">A domai n. POL. 100. 0. 1. 0. 1@.9</ cont ai ner >
<creat ed>2011- 01- 20T22: 54: 34Z</ cr eat ed>
<stat us>
<accept ed>1</ accept ed>
<read>1</read>
</ st at us>
<nsgl d>4D385ABA. domai n. POL. 200. 20000C2. 1. 42666. 1</ nsgl d>
<cl i ent Messagel d>4D38BD2A. 290 : 194 : 18298</cli ent Messagel d>
<sour ce>r ecei ved</ sour ce>
<del i vered>2011- 01- 20T22: 54: 35Z</ del i ver ed>
<security>Normal </ security>
<subj ect >ny t ask</subj ect>
<di stribution>
<fromp
<di spl ayNanme>Pr est on St ephenson</ di spl ayNane>
<emui | >pst ephenson@r est ons. provo. novel | . conx/ emai | >
<uui d>2D16B180- 0922- 0000- 846C- 82BD300F9E1C</ uui d>
</fromp
<t o>Pr eston St ephenson</to>
<sendopt i ons>
<stat usTracki ng>Al | </ st at usTracki ng>
<noti f yReci pi ent s>1</ noti f yReci pi ent s>
</ sendopti ons>
</distribution>
<options>
<priority>Standard</priority>
</ opti ons>
<si ze>939</ si ze>
<checkl i st >
<sequence>1073743359</ sequence>
<dueDat e>2011- 01- 22T19: 00: 00Z</ dueDat e>
</ checkl i st >
<retentionhMdified>2011-01-20T22: 54: 34Z</retenti onhodi fi ed>
<j unkMai | Eval uati on>
<line>Message is not eligible for Junk Mail handling</line>
<line>Message is froman internal sender</line>
</j unkMi | Eval uati on>
<j unkMai | Settings>
<line>Junk List is enabled</line>

<line>Junk Ml using personal address books is not enabl ed</line>
<line>Junk i Cal Ml using personal address books is not enabl ed</

i ne>
<line>Bl ock List is enabled</Iline>
</junkMil Settings>
<i Cal  d>2011- 01- 20T22: 54: 34Z_477A00C2@pr est ons. provo. novel | . conk/
i Cal | d>
<startDat e>2011-01- 25</ st art Dat e>
<dueDat €>2011- 01- 22</ dueDat e>
<assi gnedDat e>2011- 01- 22</ assi gnedDat e>
<taskPriority>0</taskPriority>
<ti mezone>
<dayl i ght >
<name>Mount ai n Dayl i ght Ti ne</name>
<nont h>3</ nont h>
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<dayOf Week occurrence="Second" >Sunday</ dayO Week>
<hour >0</ hour >
<m nut e>0</ m nut e>
<of f set >- 21600</ of f set >

</ dayl i ght >

<st andar d>
<nane>Mount ai n Standard Ti ne</ nane>
<mont h>11</ nont h>
<dayOf Week occurrence="First">Sunday</ dayOf Week>
<hour >0</ hour >
<m nut e>0</ m nut e>
<of f set >- 25200</ of f set >

</ st andar d>

</tinezone>

</itenp
<item type="Note">

Methods

<i d>4D385A5E. donmi n. POL. 100. 1776172. 1. 25C6A. 1@:
A. donmmi n. PQL. 100.0. 1. 0. 1@9</id>
<si d>154730</ si d>
<ver si on>3</ ver si on>
<nodi fi ed>2011- 01- 20T22: 53: 02Z</ nodi fi ed>
<cont ai ner sid="5">A. donai n. POL. 100. 0. 1. 0. 1@9</ cont ai ner >
<creat ed>2011- 01- 20T22: 53: 01Z</ cr eat ed>
<status>
<accept ed>1</ accept ed>
<read>1</read>
</status>
<msgl d>4D385A5D. donai n. POL. 200. 20000C2. 1. 42661. 1</ nsgl d>
<cl i ent Messagel d>4D38BCCD. 130 : 194 : 18298</cli ent Messagel d>
<sour ce>r ecei ved</ sour ce>
<del i vered>2011- 01- 20T22: 53: 03Z</ del i ver ed>
<security>Normal </ security>
<subj ect >y not e</ subj ect >
<di stribution>
<fromp
<di spl ayName>Pr est on St ephenson</ di spl ayNane>
<emui | >pst ephenson@r est ons. provo. novel | . conx/ emai | >
<uui d>2D16B180- 0922- 0000- 846C- 82BD300F9E1C</ uui d>
</fromp
<t o>Pr eston St ephenson</t o>
<sendopt i ons>
<st at usTr acki ng>None</ st at usTr acki ng>
<noti fyReci pi ent s>1</noti f yReci pi ent s>
</ sendopti ons>
</distribution>
<options>
<priority>Standard</priority>
</ opti ons>
<si ze>939</ si ze>
<retentionMdified>2011-01-20T22: 53: 02Z</ret enti onModi fi ed>
<j unkMai | Eval uati on>
<line>Message is not eligible for Junk Mail handling</line>
<line>Message is froman internal sender</line>
</j unkMai | Eval uat i on>
<j unkMai | Settings>



<line>Junk List is enabled</I|ine>
<l ine>Junk Mil using personal address books is not enabl ed</I|ine>
<line>Junk iCal Mil using personal address books is not enabled</
i ne>
<line>Block List is enabled</I|ine>
</junkMi | Settings>
<i Cal 1d>2011-01-20T22: 53: 01Z_477A00C2@r est ons. provo. novel | . conx/
i Cal | d>
<start Dat e>2011-01-22</ st art Dat e>
<ti mezone>
<dayl i ght >
<name>Mount ai n Dayl i ght Ti ne</name>
<nmont h>3</ mont h>
<dayOF Week occurrence="Second">Sunday</ dayOf Week>
<hour >0</ hour >
<m nut e>0</ m nut e>
<of f set >- 21600</ of f set >
</ dayl i ght >
<st andar d>
<nanme>Mount ai n Standard Ti ne</ nane>
<nmont h>11</ nont h>
<dayOF Week occurrence="First">Sunday</ dayOf Week>
<hour >0</ hour >
<m nut e>0</ m nut e>
<of f set >- 25200</ of f set >
</ st andar d>
</timezone>
</itenp
<item type="Appoi nt ment " >
<i d>4D385A03. donmi n. POL. 100. 1776172. 1. 25C67. 1@
A. donmmi n. PQL. 100. 0. 1. 0. 1@9</i d>
<si d>154727</ si d>
<ver si on>3</ ver si on>
<nodi fi ed>2011- 01- 20T22: 51: 31Z</ nodi fi ed>
<cont ai ner sid="5">A domai n. POL. 100. 0. 1. 0. 1@.9</ cont ai ner >
<creat ed>2011- 01- 20T22: 51: 31Z</ cr eat ed>
<st at us>
<accept ed>1</ accept ed>
<r ead>1</read>
</status>
<nsgl d>4D385A03. domai n. POL. 200. 20000C2. 1. 4265C. 1</ nsgl d>
<cl i ent Messagel d>4D38BC73. 63A : 194 : 18298</cli ent Messagel d>
<sour ce>r ecei ved</ sour ce>
<del i vered>2011- 01- 20T22: 51: 32Z</ del i ver ed>
<security>Normal </ security>
<subj ect >ny appoi nt nent </ subj ect >
<di stribution>
<fromp
<di spl ayNanme>Pr est on St ephenson</ di spl ayNane>
<emai | >pst ephenson@r est ons. provo. novel | . conk/ enai | >
<uui d>2D16B180- 0922- 0000- 846C- 82BD300F9ELC</ uui d>
</fronp
<t o>Preston Stephenson</to>
<sendopt i ons>
<stat usTracki ng>Al | </ st at usTracki ng>
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<notification>
<accept ed>
<mai | >1</ mai | >
</ accept ed>
</notification>
<noti f yReci pi ent s>1</ noti f yReci pi ent s>
</ sendopti ons>
</ distribution>
<opti ons>
<priority>Standard</priority>
</ opti ons>
<si ze>939</ si ze>
<retentionhdified>2011-01-20T22: 51: 31Z</retenti onhodi fi ed>
<j unkMai | Eval uati on>
<line>Message is not eligible for Junk Mail handling</line>
<line>Message is froman internal sender</line>
</ j unkMi | Eval uati on>
<j unkMai | Settings>
<line>Junk List is enabl ed</line>
<line>Junk Miil using personal address books is not enabl ed</line>
<line>Junk i Cal Ml using personal address books is not enabl ed</
i ne>
<line>Bl ock List is enabl ed</|ine>
</junkMil Settings>
<i Cal  d>2011- 01- 20T22: 51: 31Z_477A00C2@r est ons. provo. novel | . conx/
i Cal | d>
<startDate>2011-01-04T22: 30: 00Z</ st art Dat e>
<endDat e>2011- 01- 04T23: 00: 00Z</ endDat e>
<accept Level >Busy</ accept Level >
<al ar m enabl ed="1">600</ al ar nrp
<al | DayEvent >0</ al | DayEvent >
<pl ace>her e</ pl ace>
<ti mezone>
<dayl i ght >
<name>Mount ai n Dayl i ght Ti ne</ nanme>
<nmont h>3</ mont h>
<dayOF Week occurrence="Second" >Sunday</ dayCf W\eek>
<hour >0</ hour >
<m nut e>0</ m nut e>
<of f set >- 21600</ of f set >
</ dayl i ght >
<st andar d>
<name>Mount ai n St andard Ti ne</ nanme>
<nont h>11</ nont h>
<dayOF Week occurrence="First">Sunday</ dayCf Week>
<hour >0</ hour >
<m nut e>0</ m nut e>
<of f set >- 25200</ of f set >
</ st andar d>
</timezone>
</itenp
<itemtype="Mil">
<i d>4D355FEF. donwi n. POL. 100. 1776172. 1. 25C3B. 1@:
7. domai n. POL. 100. 0. 1. 0. 1@6</i d>
<si d>154683</ si d>
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<ver si on>3</versi on>
<nodi fi ed>2011- 01- 18T16: 41: 16Z</ nodi fi ed>
<cont ai ner >7. donai n. POL. 100. 0. 1. 0. 1@L6</ cont ai ner >
<created>2011-01- 18T16: 38: 48Z</ cr eat ed>
<st at us>
<opened>1</ opened>
<read>1</read>
</ st at us>
<msgl d>4D355FEF. donai n. POL. 200. 20000C2. 1. 425A3. 1</ nsgl d>
<cl i ent Messagel d>4D35C218. CBD : 194 : 18298</cli ent Messagel d>
<sour ce>r ecei ved</ sour ce>
<del i vered>2011- 01- 18T16: 40: 00Z</ del i ver ed>
<security>Normal </ security>
<subj ect >b B¥YP»D P&/ subj ect >
<di stribution>
<fromp
<di spl ayName>Pr est on St ephenson &l t; ps&gt; </ di spl ayNane>
<emui | >pst ephenson@r est ons. provo. novel | . conx/ emai | >
<uui d>2D16B180- 0922- 0000- 846C- 82BD300F9E1C</ uui d>
</fromp
<t o>pst ephenson@r est ons. provo. novel | . conx/t o>
<cc>pst ephenson@w. novel | . conx/ cc>
<sendopt i ons>
<stat usTracki ng>Al | </ stat usTracki ng>
<noti fyReci pi ent s>1</ noti f yReci pi ent s>
</ sendopti ons>
</distribution>
<opti ons>
<priority>Standard</priority>
</ opti ons>
<si ze>797</ si ze>
<retentionhMdified>2011-01-18T16: 39: 59Z</retenti onModi fi ed>
<j unkMai | Eval uati on>
<line>Message is not eligible for Junk Mail handling</line>
<line>Message is froman internal sender</line>
</j unkMi | Eval uati on>
<j unkMai | Settings>
<line>Junk List is enabled</line>
<line>Junk Ml using personal address books is not enabl ed</|ine>
<line>Junk i Cal Ml using personal address books is not enabl ed</
i ne>
<line>Bl ock List is enabled</line>
</junkMail Settings>
</itenp
</items>
<st at us>
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<code>0</ code>
</ status>
</ readCur sor Response>

<dest r oyCur sor Request >

<cont ai ner >f ol der s</ cont ai ner >
<cursor>1217918620</ cur sor >

</ dest r oyCur sor Request >

<dest r oyCur sor Response>
<st at us>
<code>0</ code>
</ st at us>
</ dest r oyCur sor Response>
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getCustomListRequest

Returns a list of custom field definitions that are defined on a post office. No values for the fields are
returned

Request

<get Cust onli st Request />

Response

<get Cust onli st Response>
<customs type="types: CustonList"/>
<status type="types: Status"/>

</ get Cust onli st Response>

Elements

customs

Returns the list of custom fields that are defined in the GroupWise system.

code

Returns the error number related to the event. 0 indicates that the request was successful.

status

Returns the success or failure of the method.

Example
<get Cust onli st Request/ >

<get Cust onli st Response>
<cust ons>
<cust omrp
<fiel d>cust onSOAP1</fi el d>
<val ue>Cust om Fi el d Val ue</val ue>
</ cust on®
</ cust ons>
<st at us>
<code>0</ code>
</ status>
</ get Cust onLi st Response>
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getDeltasRequest

Retrieves changes in the GroupWise Address Book. It returns a list of items that have changed in the
GroupWise Address Book since the last call to getDeltasRequest.

Request

<get Del t asRequest " >

<cont ai ner type="types:uid"/>

<view type="types: View'/ >

<del talnfo type="types: Deltal nfo"/>
</ get Del t asRequest >

Response

<get Del t asResponse>
<itens type="types:ltens"/>
<deltal nfo type="types: Deltal nfo"/>
<status type="types: Status"/>

</ get Del t asResponse>

Elements

container
Specifies the uid of the GroupWise Address Book. This is the only valid container at this time.
view

Specifies the elements returned for each item. The view reduces the amount of data returned. If
a view is not specified, all item elements are returned.

deltalnfo
Specifies the current state of the GroupWise Address Book.

items

Specifies the items that have changed in the GroupWise Address Book since the last
synchronization.

deltalnfo
Specifies the current state of the GroupWise Address Book.

code

Returns the error number related to the event. 0 indicates that the request was successful.

status

Returns the success or failure of the method.
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Remarks

getDeltasRequest tracks additions, deletions, and modifications to the GroupWise Address Book,

which is a good way to synchronize a local copy of the GroupWise Address Book.

The following are the steps required to retrieve and synchronize the GroupWise Address Book:

1. Getall the items in the GroupWise Address Book.
2. Get the current state of the GroupWise Address Book by calling getDeltalnfoRequest.

3. After a period of time, during which the GroupWise Address Book changed, call
getDeltasRequest to retrieve the list of changes, passing the deltalnfo element that was
returned in Step 2.

Example

<get Del t asRequest >
<cont ai ner >G oupW seSyst emAddr essBook @2</ cont ai ner >
<vi ew >
<del t al nf 0>
<firstSequence>23</first Sequence>
<l ast Sequence>23</ | ast Sequence>
<l ast Ti mePORebui | d >0</| ast Ti nrePORebui | d>
</ del t al nf 0>
</ get Del t asRequest >

<get Del t asResponse>
<itens>
<itemtype="Contact">
<i d>EDC03180- 01EE- 0000- 9D71-
9EOOF4007600@6: G oupW seSyst emAddr essBook @2</i d>
<nanme>Adni n Admi n</ nane>
<ver si on>1</versi on>
<uui d>EDC03180- 01EE- 0000- 9D71- 9E00F4007600</ uui d>
<sync>updat e</ sync>
<domai n>domai nl</ domai n>
<post O fi ce>pol</post OFfice>
<di sti ngui shedNane>Adm n. GA%/ di sti ngui shedNanme>
<useri d>Adm n</ useri d>
<ful | Nane>
<di spl ayNanme>Admi n Admi n</ di spl ayName>
<firstNanme>Adm n</first Name>
<| ast Nane>Adm n</ | ast Nanme>
</ ful | Name>
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<enai | Li st primary="Adm n. pol. domai n1">
<enai | >Adni n. pol. domai n1</ emai | >
</ emai | Li st>
</tenp
</itens>
<del t al nf 0>
<count >1</ count >
<| ast Sequence>23</ | ast Sequence>
<l ast Ti mePORebui | d>0</| ast Ti nrePORebui | d>
</ del t al nf 0>
<stat us>
<code>0</ code>
</status>
</ get Del t asResponse>
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getDeltalnfoRequest

Returns the current state of the GroupWise Address Book. The deltalnfo structure contains pointers
or sequence numbers into a dynamic list of changes in the GroupWise Address Book. An application
can update its GroupWise Address Book cache based on the sequence numbers returned in the
deltalnfo structure

Request

<get Del t al nf oRequest " >
<cont ai ner type="types:uid"/>
<view type="string"/>

</ get Del t al nf oRequest >

Response

<get Del t al nf oResponse" >
<del talnfo type="types: Del tal nfo"/>
<status type="types: Status"/>

</ get Del t al nf oResponse>

Elements

container

Specifies the uid of the GroupWise GroupWise Address Book. This is the only valid uid at this
time.

deltalnfo
Specifies the current state of the GroupWise Address Book.

deltalnfo count

In the request, specifies what items to return. -1 returns all the items in the list. If omitted, all
the items are returned. In the response, specifies the actual number of items that were
returned.

deltalnfo firstSequence

In the request, specifies the sequence or position to start the read. In the response, specifies
the first valid sequent in the list.

deltalnfo lastSequence

In the request, not used. In the response, specifies the last sequence number that was
successfully read.

deltalnfo lastTimePORebuild

Specifies the last time the administrator rebuilt the post office. A post office rebuild resets all
the sequence numbers. If a rebuild occurs, a synchronization is required before new deltas can
be applied to a local list.

code

Returns the error number related to the event. 0 indicates that the request was successful.
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status

Returns the success or failure of the method.

Remarks

The deltalnfo element has the following elements: count, firstSequence, lastSequence, and
lastTimePORebuild. Each element can be used in the request and in the response from the POA.

Example

<get Del t al nf oRequest >
<cont ai ner >G oupW seSyst emAddr essBook @2</ cont ai ner >
</ get Del t al nf oRequest >

<get Del t al nf oResponse>
<del t al nf 0>
<firstSequence>23</first Sequence>
<l ast Sequence>40</| ast Sequence>
<l ast Ti mePORebui | d>0</| ast Ti mePORebui | d>
</ del t al nf 0>
<stat us>
<code>0</ code>
</ st at us>
</ get Del t al nf oResponse>
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getDiskSpaceUsageRequest

Retrieves the disk space usage for a user.

Request

<get Di skSpaceUsageRequest >

Response

<get Di skSpaceUsageRequest >
<di skUsage type="types: D skSpaceUsage"/ >
<status type="types: Status"/>

</ get D skSpaceUsageRequest >

Elements

diskUsage

Returns the disk usage for the logged-in user.

status

Returns the success or failure of the method.
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getDocumentTypelListRequest

Returns the list of document types in a library.

Request

<get Docunent TypelLi st Request >
<library/>
</ get Docunent TypelLi st Request >

Response

<get Docunent TypelLi st Response>
<itens type="types: Docunent TypelList"/>
<status type="types: Status"/>

</ get Docunent TypelLi st Response>

Elements

library
Specifies which GroupWise library to query.

items

Returns the list of document types for a library.

code

Returns the error number related to the event. 0 indicates that the request was successful.

status

Returns the success or failure of the method.

Example

<get Docunent TypelLi st Request >
<l'i brary>domai nl. pol. pol Library@7</library>
</ get Docunent TypelLi st Request >

<get Docunent TypelLi st Response>
<itens>

<item t ype="Docunent Type" >
<nanme>Agenda</ name>
<life>99</life>
<maxi munver si ons>100</ maxi nmunver si ons>
<ageAct i on>ar chi ve</ ageAct i on>

<litenp

<item type="Docunent Type" >
<nanme>Cont r act </ nane>
<life>99</life>
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<maxi munver si ons>100</ maxi nunver si ons>
<ageAct i on>ar chi ve</ ageActi on>
</[itenp
<item type="Docunent Type" >
<nane>Cor r esp</ nane>
<life>99</|ife>
<maxi munver si ons>100</ maxi nunver si ons>
<ageAct i on>ar chi ve</ ageActi on>
<[itenp
</itens>
<stat us>
<code>0</ code>
</status>
</ get Docunent TypelLi st Response>
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getFolderRequest

Returns the specified folder. The folder can be specified by passing in the folder ID that was returned
from getFolderListRequest or by passing the folder type.

Request

<get Fol der Request >
<id type="types:uid"/>
<f ol der Type type="types: Fol der Type"/>
<types type="string"/>
<source type="string"/>
<view type="string"/>
</ get Fol der Request >

Response

<get Fol der Response>
<fol der type="types: Fol der">
<status type="types: Status">
</ get Fol der Response>

Elements
id

Specifies the ID of the folder.
folderType

Specifies an alternative way to specify the folder. The Junk Mail folder cannot be selected by
folderType. It must be selected with the folder ID.

types

Specifies the type of items to return. The types element is used to narrow the count or
unreadCount on a folder. For example, if you want the count or unreadCount for appointments
and tasks, types should equal “appointments tasks.”

source

Specifies the source of items to return. The source element is used to narrow the count or
unreadCount on a folder. For example, if you want the count or unreadCount for received and
draft items, source should equal “received draft.”

view

Specifies the elements returned for each item. The view reduces the amount of data returned. If
a view is not specified, all item elements are returned. Valid views are as follows:

count Retrieves the count of items in a folder. The count is available only on mailbox,
personal, and draft folders. Hidden items in a folder are not part of the count.

unreadCount Retrieves the count of unread items in a folder.

default Retrieves other folder fields.
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folder

Specifies the selected folder details.

code

Returns the error number related to the event. 0 indicates that the request was successful.

status

Returns the success or failure of the method.

Example

<get Fol der Request >

<f ol der Type>Mai | box</f ol der Type>

<vi ew>default count unreadCount</vi ew>
</ get Fol der Request >

<get Fol der Response>
<f ol der >
<i d>7. donmmi nl. pol. 100.0.1.0.1@6</id>
<name>Mi | box</ nane>
<nodi fi ed>2012- 08- 25T17: 38: 39Z</ nodi fi ed>
<par ent >6. domai nl. pol. 100. 0. 1. 0. 1@.5</ par ent >
<count >5</ count >
<hasUnr ead>1</ hasUnr ead>
<unr eadCount >3</ unr eadCount >
<sequence>5</ sequence>
<i sSyst enfol der >1</i sSyst enfol der >
<f ol der Type>Mai | box</ f ol der Type>
</ fol der >
<st at us>
<code>0</ code>
</ status>
</ get Fol der Response>
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getFolderListRequest

Returns the list of folders.

Request

<get Fol der Li st Request >
<parent type="types:uid"/>
<view type="string"/>
<recurse type="bool ean"/ >
<i map type="bool ean"/>
<nntp type="bool ean"/>

</ get Fol der Li st Request >

Response

<get Fol der Li st Response>
<fol ders type="types: Fol derList/>
<status type="types: Status/>

</ get Fol der Li st Response>

Elements

parent

Specifies the ID of the folder from which to get the list of folders. If the value of the parent
property is the string folders, the root folder is searched.

view

Specifies the elements returned for each item. The view reduces the amount of data returned. If
a view is not specified, all item elements are returned.

recurse

Specifies whether subfolders beneath the parent folder are returned.

imap

Specifies if IMAP folders are returned.

nntp
Specifies if NNTP folders are returned.

folders

Returns the list of folders.

code

Returns the error number related to the event. 0 indicates that the request was successful.

status

Returns the success or failure of the method.
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Example

<get Fol der Li st Request >
<par ent >f ol der s</ par ent >
<vi ew >
<recur se>true</recurse>
<i map>f al se</i map>
<nnt p>f al se</ nnt p>

</ get Fol der Li st Request >

<get Fol der Li st Response>
<f ol der s>
<f ol der type="Systenfol der">
<i d>6. domai nl. pol. 100. 0. 1. 0. 1@5</i d>
<nanme>ul</ name>
<nodi fi ed>2005- 06- 29T23: 28: 26Z</ nodi fi ed>
<count >1</ count >
<hasUnr ead>1</ hasUnr ead>
<unr eadCount >1</ unr eadCount >
<sequence>0</ sequence>
<i sSyst entol der >1</i sSyst enfol der >
<f ol der Type>Root </ f ol der Type>
</ fol der>
<f ol der type="Systenfol der">
<i d>7. domai nl. pol. 100. 0. 1. 0. 1@6</id>
<nanme>Mai | box</ name>
<nodi fi ed>2012- 08- 25T17: 38: 39Z</ nodi fi ed>
<par ent >6. domai nl. pol. 100. 0. 1. 0. 1@.5</ par ent >
<count >2</ count >
<sequence>5</ sequence>
<i sSyst entol der >1</i sSyst enfol der >
<f ol der Type>Mai | box</ f ol der Type>
<acl >
<entry>
<di spl ayName>u2</ di spl ayNane>
<emai | >u2. pol. donui nl</ emai | >
<uui d>42F9A600- 175B- 0000- 890F- 6EO0D5004E00</ uui d>
<ri ghts>
<read>1</read>
<add>1</ add>
<edit>1</edit>
<del et e>1</ del et e>
</rights>
</entry>
</ acl >
<i sShar edByMe>1</ i sShar edBy Me>
</ fol der>
<fol der type="Systenfol der">
<i d>19. donmai nl. pol. 100. 0. 1. 0. 1@0</i d>
<nane>Sent |t ens</ nanme>
<nodi fi ed>2012- 09- 05T20: 43: 47Z</ modi fi ed>
<par ent >6. domai nl. pol. 100. 0. 1. 0. 1@.5</ par ent >
<sequence>6</ sequence>
<i sSyst enfol der >1</i sSyst enfol der >
<f ol der Type>Sent | t ens</ f ol der Type>
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</ fol der>
<f ol der type="Systentol der">

<i d>A. donmi nl. pol. 100.0.1.0.1@09</id>
<nane>Cal endar </ nane>
<nodi fi ed>2012- 09- 06T23: 08: 05Z</ nodi f i ed>
<par ent >6. domai nl. pol. 100. 0. 1. 0. 1@.5</ par ent >
<count >7</ count >
<sequence>7</ sequence>
<i sSyst enfol der >1</i sSyst enfol der >
<f ol der Type>Cal endar </ f ol der Type>
<acl >
<entry>

<di spl ayNane>u2</ di spl ayNanme>

<emai | >u2. pol. domai nl</ enmuil >

<uui d>42F9A600- 175B- 0000- 890F- 6EO0D5004E00</ uui d>

<rights>

<r ead>1</read>
<add>1</ add>
</rights>
</entry>

</ acl >
<i sShar edByMe>1</ i sShar edBy Me>

</fol der>
<f ol der type="SharedFol der">

<i d>44FF0075. domai nl. pol. 100. 16E3837. 1. FB4. 1@5</i d>
<name>ul Personal Cal endar </ nanme>
<nodi fi ed>2012- 09- 06T23: 10: 37Z</ nodi fi ed>
<par ent >A. domai nl. pol. 100. 0. 1. 0. 1@9</ par ent >
<count >1</ count >
<sequence>0</ sequence>
<cal endar Attri but e>
<f | ags>Showl nLi st </f| ags>
</ cal endar Attri but e>
<acl >
<entry>
<di spl ayNane>u2</ di spl ayNane>
<emai | >u2. pol. donai n1@hant om conx/ enai | >
<uui d>42F9A600- 175B- 0000- 890F- 6EO0D5004E00</ uui d>
<ri ghts>
<read>1</read>
<add>1</add>
<edit>1</edit>
<del et e>1</ del et e>
</rights>
<st at us>accept ed</ st at us>
</entry>
</ acl >
<i sShar edByMe>1</ i sShar edBy Me>

</fol der>
<f ol der type="Contact Fol der">

<i d>1B. domai nl. pol. 100. 0. 1. 0. 1@2</i d>
<nanme>Cont act s</ nane>

<nmodi fi ed>2012- 08- 25T17: 38: 39Z</ nodi fi ed>
<par ent >6. domai nl. pol. 100. 0. 1. 0. 1@5</ par ent >
<sequence>8</ sequence>



<i sSyst enfol der >1</i sSyst enfol der >
<f ol der Type>Cont act s</f ol der Type>
<addr essBook>42C510EA. domai nl. pol. 104. 16E3837. 1. 1. 1@®3
</ addr essBook>

</fol der>

<fol der type="Systenfol der">
<i d>10. donmi nl. pol. 100.0.1.0. 1@3</id>
<nane>Docunent s</ hane>
<nmodi fi ed>2012- 08- 25T17: 38: 39Z</ nodi fi ed>
<par ent >6. domai nl. pol. 100. 0. 1. 0. 1@L5</ par ent >
<sequence>9</ sequence>
<i sSyst enFol der >1</ i sSyst enfol der >
<f ol der Type>Docunent s</f ol der Type>

</ fol der>

<fol der type="QueryFol der">
<i d>11. domai nl. pol. 100. 0. 1. 0. 1@4</i d>
<nane>Aut hor ed</ nane>
<nodi fi ed>2005- 06- 29T23: 28: 15Z</ nodi f i ed>
<parent >10. domai nl. pol. 100. 0. 1. 0. 1@3</ par ent >
<sequence>0</ sequence>
<f ol der Type>Quer y</f ol der Type>

</fol der>

<fol der type="Systentol der">
<i d>1A. domai nl1. pol. 100. 0. 1. 0. 1@1</i d>
<nanme>Checkl i st </ nane>
<nodi fi ed>2012- 08- 25T17: 38: 39Z</ nodi fi ed>
<par ent >6. domai nl. pol. 100. 0. 1. 0. 1@L5</ par ent >
<sequence>10</ sequence>
<i sSyst enFol der >1</i sSyst enfol der >
<f ol der Type>Checkl i st </ f ol der Type>

</fol der>

<f ol der type="Systentol der">
<i d>D. domai nl1. pol. 100. 0. 1. 0. 1@2</i d>
<name>Work I n Progress</name>
<nodi fi ed>2012- 08- 25T17: 38: 39Z</ nodi fi ed>
<par ent >6. domai nl. pol. 100. 0. 1. 0. 1@L5</ par ent >
<sequence>11</ sequence>
<i sSyst enfol der >1</ i sSyst enfol der >
<f ol der Type>Dr aft </ f ol der Type>

</fol der>

<fol der type="Systentol der">
<i d>C. domai nl. pol. 100. 0. 1. 0. 1@1</i d>
<nane>Cabi net </ nane>
<nodi fi ed>2012- 08- 25T17: 38: 39Z</ nodi fi ed>
<par ent >6. domai nl. pol. 100. 0. 1. 0. 1@L5</ par ent >
<count >3</ count >
<hasUnr ead>1</ hasUnr ead>
<unr eadCount >3</ unr eadCount >
<sequence>12</ sequence>
<i sSyst entol der >1</i sSyst enfol der >
<f ol der Typ